Installation Guide

SAP NetWeaver Composition Environment 7.1 SR5 on Windows: IBM DB2 for z/OS

Production Edition

Target Audience

- System Administrators
- Technical Consultants

Document version: 1.1 - 05/16/2008
Document History

⚠️ Caution
Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at http://www.sdn.sap.com/irj/sdn/nw-ce.

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>5/16/2008</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>
# Table of Contents

**Chapter 1**  
Introduction ........................................... 7  
1.1  
How to Use This Guide .................................. 7  
1.2  
New Features ............................................. 8  
1.3  
SAP Notes for the Installation ........................... 11  
1.4  
Online Information from SAP ............................. 12  
1.5  
Accessing the SAP Library ............................... 14  
1.6  
Naming Conventions ...................................... 14

**Chapter 2**  
Planning .................................................. 17  
2.1  
Installation Options Covered by this Guide .......... 17  
2.1.1  
Standard System ........................................ 18  
2.1.2  
High-Availability System ............................... 19  
2.1.3  
Additional Application Server Instance ............ 19  
2.1.4  
Standalone Host Agent .................................. 21  
2.2  
Domain or Local Installation ............................ 22  
2.3  
SAP System Transport Host ............................. 23  
2.4  
Running Adobe Document Services on Nonsupported Platforms .... 24  
2.5  
Integration of LDAP Directory Services ............... 24  
2.6  
Implementation Considerations for MCOD ............. 28  
2.7  
Installation of Multiple Components in One Database .. 29

**Chapter 3**  
Preparation ................................................ 31  
3.1  
Basic SAP System Parameters ............................ 32  
3.2  
Hardware and Software Requirements .................. 39  
3.2.1  
Running the Prerequisite Checker in Standalone Mode (Optional) .. 41  
3.2.2  
Requirements for a Standard System .................. 42  
3.2.3  
Requirements for a High Availability System ........ 43  
3.2.4  
Requirements for z/OS .................................. 46  
3.2.5  
Requirements for DB2 for z/OS .......................... 48  
3.2.6  
Necessary z/OS Group and User IDs .................... 50  
3.2.7  
Requirements for the Additional Application Server Instance .... 51  
3.2.8  
Requirements for the Host Agent as a Separate Installation ... 51  
3.3  
Preparing User Management for an External ABAP System .... 53  
3.4  
Checking the Windows File System .................... 56  
3.5  
Checking the Windows Domain Structure ................ 56
3.6 Reducing the Size of the File Cache ................................................. 57
3.7 Required User Authorization for the Installation .......................... 58
3.8 Performing a Domain Installation Without Being a Domain Administrator 59
3.9 Preparing the SAP System Transport Host ................................... 62
3.10 Generating the SAP Solution Manager Key .................................... 63
3.11 Preparing the Installation DVDs .................................................. 63
3.12 Preparing z/OS for SAPinst ........................................................ 68

Chapter 4

Installation .......................................................... 67
4.1 Running SAPinst ................................................................. 68
4.2 Performing a Remote Installation with SAPinst (Optional) ............... 71
4.3 SAPinst Installation Options .................................................. 72
4.4 Interrupted Installation with SAPinst ........................................ 105
4.5 Starting SAPinst GUI Separately (Optional) ............................... 76
4.6 Entries in the Services File Created by SAPinst ............................ 106
4.7 Installing Additional Components (Optional) ............................ 78
4.8 Installing SAP Memory Analyzer (Optional) .............................. 80

Chapter 5

Post-Installation .................................................. 83
5.1 Configuring the Windows Server 2008 Firewall ............................ 84
5.2 Logging On to the Application Server ...................................... 85
5.3 Ensuring User Security ....................................................... 86
5.4 Installing the SAP License .................................................... 88
5.5 Creating Symbolic Links on Windows Server 2008 for Application Servers 89
5.6 Configuring the Transport Management System .......................... 90
5.7 Configuring the Remote Connection to SAP Support ..................... 90
5.8 Applying the Latest Kernel and Support Packages ....................... 90
5.9 Post-Installation Steps for the Host Agent ................................. 91
5.10 Checking the SAP Java Documentation ................................... 92
5.11 CE-Specific Post-Installation Activities .................................. 93
5.12 Performing a Full System Backup ......................................... 96
5.13 Post-Installation Steps for the Diagnostics Agent ....................... 97

Chapter 6

Additional Information ............................................ 99
6.1 Transporting Self-Developed Software Component Archives (SCA) into the System ......................................................... 99
6.2 Configuration Templates ..................................................... 100
6.3 Uninstalling SAP NetWeaver Composition Environment ................ 101
6.4 SAP Directories ............................................................... 101
6.5 Additional Information About SAPinst .................................. 104
6.5.1 Interrupted Installation with SAPinst .................................. 105
6.5.2 Entries in the Services File Created by SAPinst ..................... 106
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.5.3</td>
<td>How to Avoid Automatic Logoff by SAPinst</td>
<td>106</td>
</tr>
<tr>
<td>6.5.4</td>
<td>Troubleshooting with SAPinst</td>
<td>107</td>
</tr>
<tr>
<td>6.6</td>
<td>Starting and Stopping the SAP System</td>
<td>108</td>
</tr>
<tr>
<td>6.7</td>
<td>Database Build Phase</td>
<td>109</td>
</tr>
<tr>
<td>6.8</td>
<td>Database Post Load Phase</td>
<td>111</td>
</tr>
<tr>
<td>6.9</td>
<td>saposcol, sapccmsr and SAPCL</td>
<td>112</td>
</tr>
<tr>
<td>6.10</td>
<td>SAP System Security on Windows</td>
<td>112</td>
</tr>
<tr>
<td>6.11</td>
<td>Automatic Creation of Accounts and Groups</td>
<td>114</td>
</tr>
<tr>
<td>6.12</td>
<td>Deleting an SAP System</td>
<td>116</td>
</tr>
<tr>
<td>6.13</td>
<td>Deleting the Database Instance</td>
<td>117</td>
</tr>
</tbody>
</table>
1 Introduction

This document explains how to install an SAP NetWeaver Composition Environment system as productive edition.
For more information about SAP NetWeaver Composition Environment, see http://sdn.sap.com/irj/sdn/nw-ce.

Constraints
You need to consider the following constraints before you start your installation:

- You must only use the SAP installation tools according to the instructions and for the purposes described in the SAP installation document. Improper use of the SAP installation tools can damage files and systems already installed.
- SAP system installations should only be performed by SAP Technical Consultants certified for your operating system, your database, and the SAP system that you are installing.
- For downward-compatible releases of DB/OS platforms for SAP products, SAP plans to regularly release the newest database (DB) and operating-system (OS) versions of SAP products. These releases are downward-compatible with earlier SAP system releases.

Note that for already shipped SAP components, we only support the installation for database versions proposed by the installation tool. Therefore, you must install an SAP component or perform a system copy using a downward-compatible database as follows:
- Install the component with the old proposed database version.
- Upgrade the old database version to the downward-compatible new version.

1.1 How to Use This Guide

At the beginning of each installation phase – planning, preparation, installation, and post-installation – you find a list of the steps that you have to perform in that phase, as well as additional information. Detailed information about the steps for each phase is available in the relevant chapter.

When you plan the installation, you have to decide what exactly you want to install, because the steps within each phase vary according to the installation option you choose.

The following installation options are described in this document:

- Standard system (formerly known as central system)
- High-availability system
- Additional application server instance(s)
- Standalone host agent
1.2 New Features

Here you can find the new features in this release.

⚠️ Caution

Make sure that you read the release notes for your SAP system. You can find these at [http://service.sap.com/releasenotes](http://service.sap.com/releasenotes).

SAP System Installation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAPInst</td>
<td>SAPInst has the following new features:</td>
</tr>
<tr>
<td></td>
<td>- The technical terms used for the instances of an SAP system have changed as follows:</td>
</tr>
</tbody>
</table>
|                             |   - “Central instance” (CI) is now called “primary application server instance”.  
|                             |   - “Dialog instance” (DI) is now called “additional application server instance”.                                                                                                                                                                                                                                                      |
|                             | ![Note](https://example.com/note_icon.png) The technical terms “Database instance”, “Java central services instance” (SCS), and “ABAP central services instance” (ASCS) remain unchanged.                                                                                                                                                                |
|                             | - “Central system” — meaning an SAP system running on one single host — is now called “standard system”.                                                                                                                                                                                                                                    |
|                             | - Host agent                                                                                                                                                                                                                                                                                                                             |
|                             |   The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components, except TREX.                                                                                                           |
|                             |   The host agent is automatically installed with your SAP system.                                                                                                                                                                                                                                                                     |
|                             |   You can also install a standalone host agent with SAPInst. There is a new installation option Host Agent available under [Software Life-Cycle Options > Additional Preparations](https://example.com/software).                                                                                                                                     |
|                             |   You only need to install a standalone host agent in the following cases:                                                                                                                                                                                                     |
|                             |   - You want to centrally monitor a host that does not have an SAP component.                                                                                                                                                                                              |
|                             |   - You want to perform an upgrade to SAP NetWeaver.                                                                                                                                                                                                                         |
|                             | - The locations of all installation DVDs can be entered on one screen.                                                                                                                                                                                                       |
| Software Deployment Manager (SDM) no longer available in the Application Server Java | The Software Deployment Manager (SDM) is no longer part of the primary application server instance of a Java-only system. Therefore, there is no longer any technical difference between the primary application server instance and the additional application server instance of a Java-only system. The SAP system directory of both instances is now called J<instance_number>. J<instance_number> no longer exists. |

---

6/2008
### Area | Description
--- | ---
Usage type EP Core (EPC) | The usage type Enterprise Portal (EP) is divided into the usage types EP Core (EPC) and Enterprise Portal (EP):
- **EP Core (EPC)**
  - This usage type contains the core portal capabilities that were available in the former usage type EP. This new usage type provides more flexibility when implementing a portal where the full enterprise portal capabilities, such as knowledge management and collaboration, are not required. It contains the portal, GP, and UWL.
- **Enterprise Portal (EP)**
  - This usage type includes Knowledge management, Collaboration, CAF-Core, Visual Composer, Web Dynpro extension, and .NET PDK.
Usage type EPC is a prerequisite for usage type EP. If you want to obtain the full capabilities of the former usage type EP, you need both EP Core and EP. The configuration of EPC comprises only portal configuration steps.

| Installation DVDs | You start the installation from the Installation Master DVD for your database. |
| Java Library | There is no longer a Java library for Java systems. Everything is now in the kernel. You no longer need `APYJ2ELIB` and `RMVJ2ELIB`. |
| SAP Java Virtual Machine (SAP JVM) | You no longer have to download and install a Java Development Kit (JDK) from another software vendor as a prerequisite for the installation with SAPinst. The SAP JVM is a Java Development Kit (JDK) provided and supported by SAP. The SAP JVM is fully compliant to the Java Standard Edition 5. It is available on the Installation Master DVD and is installed automatically by SAPinst when you start the installation. |
| Visual Administrator tool integrated in SAP NetWeaver Administrator | SAP NetWeaver Administrator is a brand new solution for monitoring and administering Java systems and their applications. It is a web-based tool for administration, configuration, and monitoring. The Visual Administrator tool is no longer available as a separate tool. It has been integrated in the SAP NetWeaver Administrator. SAP NetWeaver Administrator offers you most of the functions previously available in Visual Administrator, but redesigned for the task-oriented approach of SAP NetWeaver Administrator. For more information about SAP NetWeaver Administrator, see the SAP NetWeaver Master Guide and the following: |
### Area New Features

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Solution Manager</td>
<td>A SAP Solution Manager Diagnostics Agent (Diagnostics Agent) is a standalone Java program that runs on each of the systems managed by SAP Solution Manager Diagnostics. It gathers information and reports to the SAP Solution Manager system. For more information about the Diagnostics Agent, see <a href="http://service.sap.com/diagnostics">http://service.sap.com/diagnostics</a>. The installation of the Diagnostics Agent is now part of the Installation Master DVD. That is, you can choose between the following options:</td>
</tr>
<tr>
<td>SAP Solution Manager</td>
<td></td>
</tr>
<tr>
<td>Diagnostics Agent</td>
<td>- If there is no Diagnostics Agent already installed on this physical or virtual host, it is installed automatically with an ASJava primary application server instance and additional application server instance.</td>
</tr>
<tr>
<td></td>
<td>- You can also install it as a standalone engine, for example if you want a non-SAP system to be managed by SAP Solution Manager Diagnostics.</td>
</tr>
<tr>
<td></td>
<td>The installation of the Diagnostics Agent as a standalone engine is not described in this installation guide, but in the Diagnostics Agent Setup Guide, which is available at <a href="http://service.sap.com/diagnostics">http://service.sap.com/diagnostics</a>.</td>
</tr>
<tr>
<td>IBM DB2 Version 9.1 for z/OS</td>
<td>SAP kernel 7.10 supports DB2 V9.1 for z/OS, the new database version. DB2 V9.1 for z/OS is capable of implicitly creating databases and tablespaces. However, you can continue using IBM DB2 UDB for z/OS Version 8 with your SAP system. Both versions are referred to as DB2 for z/OS in this documentation.</td>
</tr>
<tr>
<td>IBM DB2 Driver for ODBC and CLI V9</td>
<td>When you install SAP, you do not need to install DB2 Connect, since the IBM DB2 Driver for ODBC and CLI V9 is installed automatically with SAPinst. For more information, see <a href="http://www.sdn.sap.com/irj/sdn/db2">http://www.sdn.sap.com/irj/sdn/db2</a> SAP on DB2 for z/OS Knowledge Center SAP Best Practices Best Practice for Installing or Migrating to DB2 V9</td>
</tr>
</tbody>
</table>
| | **Note** The IBM DB2 Driver for ODBC and CLI V9 can be used with both database versions – DB2 V9.1 and DB2 UDB for z/OS Version 8.
1.3 SAP Notes for the Installation

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note, which you can find at http://service.sap.com/notes.

SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>965569</td>
<td>SAP NetWeaver Installation Based On Kernel 7.10: Windows</td>
<td>Windows-specific information about the SAP system installation and corrections to this documentation.</td>
</tr>
<tr>
<td>73606</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems</td>
</tr>
</tbody>
</table>
## 1.4 Online Information from SAP

More information is available online as follows.

**Documentation**

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
</table>
### Description

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Security Guide for SAP systems running with IBM DB2 for z/OS (was</td>
<td><a href="http://service.sap.com/operationsnwmobile71">http://service.sap.com/operationsnwmobile71</a></td>
<td>SAP Security Guide for IBM DB2 for z/OS</td>
</tr>
<tr>
<td>formerly part of the SAP Planning Guide: DB2 for z/OS)</td>
<td>Database-Specific Guides</td>
<td></td>
</tr>
<tr>
<td>This guide is also valid for SAP NetWeaver CE 7.1.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>You need this guide to install sapccmsr, which is the tool that connects</td>
<td><a href="http://service.sap.com/operationsnwmobile71">http://service.sap.com/operationsnwmobile71</a></td>
<td>Monitoring Setup Guide for NW &lt;version&gt;</td>
</tr>
<tr>
<td>saposco1 to the SAP application server.</td>
<td>Monitoring</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SAP Components</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SAP Solution Manager Release 4.0</td>
<td></td>
</tr>
</tbody>
</table>

### General Quick Links

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP on DB2 for z/OS</td>
<td><a href="http://www.sdn.sap.com/irj/sdn/db2">http://www.sdn.sap.com/irj/sdn/db2</a></td>
</tr>
<tr>
<td>SAP Notes</td>
<td><a href="http://service.sap.com/notes">http://service.sap.com/notes</a></td>
</tr>
<tr>
<td>Product Availability Matrix (PAM)</td>
<td><a href="http://service.sap.com/pam">http://service.sap.com/pam</a></td>
</tr>
<tr>
<td>System sizing (Quick Sizer tool)</td>
<td><a href="http://service.sap.com/sizing">http://service.sap.com/sizing</a></td>
</tr>
</tbody>
</table>
### 1.5 Accessing the SAP Library

For more information about SAP NetWeaver, access the SAP Library from the SAP Help Portal at [http://help.sap.com](http://help.sap.com).

The references to SAP NetWeaver Library documentation in this documentation always refer to the following entry point on the SAP Help Portal:

### 1.6 Naming Conventions

In this documentation, the following naming conventions apply:

**Terminology**

- SAP system refers to SAP NetWeaver CE 7.1.
- Diagnostics Agent refers to SAP Solution Manager Diagnostics Agent.

**IBM Product Terminology**

- IBM DB2 for z/OS is referred to as either DB2 for z/OS or DB2.
- IBM DB2 Version 9.1 for z/OS is referred to as DB2 V9 for z/OS.
- DB2 Connect refers to both the IBM DB2 Driver for ODBC and CLI V9 and the JDBC Driver.
- IBM DB2 Driver for ODBC and CLI V9 is referred to as CLI and JDBC Drivers or thin client in the short form.

**SAP on IBM DB2 for z/OS Guide Terminology**

- SAP Planning Guide for SAP NetWeaver on IBM DB2 for z/OS is referred to as SAP Planning Guide: DB2 for z/OS.
- SAP Database Administration Guide for SAP NetWeaver on IBM DB2 for z/OS

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td></td>
</tr>
<tr>
<td>For information on Windows operating system security, see:</td>
<td><a href="http://www.microsoft.com/security">http://www.microsoft.com/security</a></td>
</tr>
<tr>
<td>SAP Solution Manager</td>
<td><a href="http://service.sap.com/solutionmanager">http://service.sap.com/solutionmanager</a></td>
</tr>
</tbody>
</table>
is referred to as

*SAP DBA Guide: DB2 for z/OS.*

### Variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;SAPSID&gt;</td>
<td>SAP system ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;sapsid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;sid&gt; and &lt;sapsid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;DBSID&gt;</td>
<td>Database ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;dbsid&gt;</td>
<td>Database ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;host_name&gt;</td>
<td>Name of the corresponding host</td>
</tr>
<tr>
<td>&lt;INSTDIR&gt;</td>
<td>Installation directory for the SAP system</td>
</tr>
<tr>
<td>&lt;DVD_DIR&gt;</td>
<td>Directory on which a DVD is mounted</td>
</tr>
<tr>
<td>&lt;OS&gt;</td>
<td>Operating system name within a path</td>
</tr>
<tr>
<td>&lt;SCHEMAID&gt;</td>
<td>Database schema ID</td>
</tr>
</tbody>
</table>

The following example shows how the variables are used:

**Example**

Log on as user `<sapsid>adm` and change to the directory `\usr\sap\<SAPSID>`.

If your SAP system ID is C11, log on as user `c11adm` and change to the directory: `\usr\sap\C11`. 
2 Planning

This section provides general planning information.

You must first:

1. Plan your SAP system landscape according to the Master Guide and the Technical Infrastructure Guide available for your product.
2. Decide on your installation option [page 17].

Now continue with the section for your chosen installation option below.

Standard, Distributed, or High-Availability System

Note
Since an SAP on IBM DB2 for z/OS system is always a distributed constellation, we only offer a standard or high-availability installation option.

1. You decide whether you want to perform a domain or local installation [page 22].
2. You decide on the transport host to use [page 23].
3. If you want to use Adobe Document Services (ADS), you check what you have to do if your platform is not supported for ADS [page 24].
4. You read through the implementation considerations for MCOD [page 28].
5. You decide whether you want to install multiple components in one database (MCOD) [page 29].
6. You can now continue with Preparation [page 31].

Additional Application Server Instance
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 31].

Host Agent as a Standalone Installation
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 31].

2.1 Installation Options Covered by this Guide

This section shows the installation options covered by this installation guide.

Standard system [page 18] (formerly known as central system)
2 Planning

2.1 Installation Options Covered by this Guide

- High-availability system [page 43]
- You can install one to <n> additional application server instance(s) [page 19] to an existing standard or high-availability system.
- You can install a standalone host agent [page 21].

2.1.1 Standard System

In a standard system, your primary application server instance runs on Linux, UNIX or Windows, and your database host on z/OS. The ASCS and SCS instances may run on any of these operating system hosts, however we recommend you install them on z/OS.

For more information, see High-Availability System [page 19].

The following figure shows an example of SAP instances in a standard (central) system, where the mandatory instances are all installed on one host, except for the database instance, which is on System z:

Figure 1: Standard Java System IBM DB2 for z/OS

Optionally you can install one or more additional application server instances. For more information, see Additional Application Server Instance [page 19].
2.1.2 High-Availability System

In a high-availability system, every instance can run on a separate host:

- Java Central Services Instance (SCS)
- Database instance (DB)
- Primary application server instance (PAS)

Both the ASCS and the SCS must each have their own Enqueue Replication Server (ERS) instance. Optionally you can install one to \(<n>\) additional application server instances. For more information, see Installation of an Additional Application Server Instance [page 19].

**Recommendation**

We recommend that you install the ASCS and SCS instances on z/OS in a high-availability system. For more information, see the SAP Planning Guide: DB2 for z/OS.

The following figure shows an example of the distribution of the SAP instances in a high-availability system.

**Figure 2:** High-Availability System Java – IBM DB2 for z/OS

2.1.3 Additional Application Server Instance

You can install one or more additional application server instance(s) for an existing SAP system.
An additional application server instance can run on a dedicated host.

**Note**

We do not recommend installing additional application server instance(s) on the SAP global host.

**Additional Application Server Instance for a Standard System**

The following figure shows three additional application server instances running on a dedicated host. For additional information, see *Standard System* [page 18].

**Figure 3:** Additional Application Server Instance for a Standard System – IBM DB2 for z/OS

**Additional Application Server Instance for a High-Availability System**

In a high-availability system, you require besides the primary application server instance, at least one additional application server instance. The following figure is an example of such a system.
2.1.4 Standalone Host Agent

Using the host agent you can centrally monitor any host with the Alert Monitor or the SAP NetWeaver Administrator or the Adaptive Computing Controller (ACC). In addition, the host agent is used by the ACC for starting, stopping, and relocating SAP instances and databases. For more information on the ACC see [http://sdn.sap.com/irj/sdn/adaptive](http://sdn.sap.com/irj/sdn/adaptive).

The host agent is automatically installed during the installation of all SAP NetWeaver instances and components.

You only need to install a **standalone** host agent in the following cases:

- You want to manage a host that does not have an SAP instance or component.
- You have upgraded your SAP system to SAP NetWeaver 7.1 or higher and want to the instances of the upgraded system to be managed by the ACC.
The host agents contain the following elements:

- The control program `saphostexec`
- The SAP NetWeaver Management agent `SAPHostControl` (`sapstartsvr` in host mode)
- The `sapacosprep` executable of the Adaptive Computing Infrastructure
- The operating system collector `saposcol`

**Note**

The installed programs are automatically started when the host is booted. On Microsoft Windows hosts, the services `SAPHostControl` and `SAPHostExec` do this.

**More Information**

For more information about the host agent, see the SAP Library [page 14]:
- Function-Oriented View ➤ Application Server ABAP ➤ Administration Tools for AS ABAP ➤ Monitoring in the CCMS ➤ Infrastructure of the NetWeaver Management Agents ➤

### 2.2 Domain or Local Installation

Before you install the SAP system, you have to decide whether you want to perform a domain or local installation, since this affects how the user account information is stored and accessed.

For more information about the differences between a local and domain installation, see the Microsoft article *Deciding Between Workgroups and Domains* at:
**Domain Installation**

In a domain installation, the user account information is stored centrally in one database on the domain controller and is accessible to all hosts in the system.

You have to perform a domain installation if one of the following applies:

- You install a distributed system (strongly recommended to avoid authorization problems).
- You use a common transport host for several SAP systems running on different computers.

**Local Installation**

In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

**Note**

If your SAP system was installed as a local installation and you want to later change to a domain installation, you must perform a homogeneous system copy. For more information, see the documentation Homogeneous and Heterogeneous System Copy for SAP Systems based on SAP NetWeaver at:

http://service.sap.com/instguides <your product> 4

**More Information**

**Required User Authorization for the Installation** [page 58]

### 2.3 SAP System Transport Host

The transport host contains the transport directory that is used by the SAP transport system to store transport data and change information of SAP systems, such as software programs, data dictionary data, or customization data. If you have several SAP systems they are usually organized in transport domains. In most cases, all SAP systems in a transport domain have a common transport directory. For more information, see the SAP Library [page 14]:

- Administrator’s Guide
- Technical Operations Manual
- General Administration Tasks
- Software Life Cycle Management
- Software Logistics
- Change and Transport System
- Change and Transport System — Overview (BC-CTS)
- Basics of the Change and Transport System
- Transport Management System — Concept

When you install an SAP system, SAPinst by default creates the transport directory on the primary application server instance host in \usr\sap\trans.

You have to prepare this host for use by the new SAP system if one of the following applies to you:

- You want to locate the transport directory on another host.
- You want to use an existing transport host and directory in your SAP system landscape.

For more information, see Preparing the SAP System Transport Host [page 62].
2.4 Running Adobe Document Services on Nonsupported Platforms

Adobe document services (ADS) are currently not supported to run natively on all platforms supported by SAP systems based on SAP NetWeaver, in particular on 64-bit platforms.

Procedure
To use ADS in SAP landscapes on nonsupported platforms, install an additional standalone AS Java on a platform supported by ADS.
For more information, see SAP Note 925741.

More Information
For more information about running ADS on SAP systems based on SAP NetWeaver, see http://sdn.sap.com/irj/sdn/adobe.

2.5 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol (LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the directory.

LDAP defines a standard protocol for accessing directory services, which is supported by various directory products such as Microsoft Active Directory, and OpenLDAP slapd. Using directory services enables important information in a corporate network to be stored centrally on a server. The advantage of storing information centrally for the entire network is that you only have to maintain data once, which avoids redundancy and inconsistency.

If an LDAP directory is available in your corporate network, you can configure the SAP system to use this feature. For example, a correctly configured SAP system can read information from the directory and also store information there.
The SAP system can interact with the Active Directory using the LDAP protocol, which defines:

- The communication protocol between the SAP system and the directory
- How data in the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows server, you can configure the SAP system to use the information available there. In the following text, directories other than the Active Directory that implement the LDAP protocol are called **generic LDAP directories**.

**Prerequisites**

You can only configure the SAP system for Active Directory services or other LDAP directories if these are **already available** on the network. As of Windows 2000 or higher, the Active Directory is automatically available on all domain controllers. A generic LDAP directory is an additional component that you must install separately on a UNIX or Windows server.

**Features**

In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory by using:

- SAP Logon
- The SAP Microsoft Management Console (SAP MMC)

For more information about the automatic registration of SAP components in LDAP directories and the benefits of using it in SAP Logon and SAP MMC, see the documentation [SAP System Information in Directory Services](http://service.sap.com/msplatforms) on SAP Service Marketplace at:

[http://service.sap.com/msplatforms](http://service.sap.com/msplatforms)  
Microsoft  
Windows Server

**SAP Logon**

Instead of using a fixed list of systems and message servers, you can configure SAP Logon in the `sapmsg.ini` configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon to use the LDAP directory, it queries the directory each time `Server` or `Group` selection is chosen to fetch up-to-date information on available SAP systems.

To use LDAP operation mode, make sure that the `sapmsg.ini` file contains the following:
2.5 Integration of LDAP Directory Services

Address
Mode=LDAPdirectory
LDAPserver=
LDAPnode=
LDAPoptions=

Distinguish the following cases:

- If you use an Active Directory, you must set `LDAPoptions="DirType=NT5ADS"`. For more information, see the SAP system profile parameter `ldap/options`.
- You must specify the directory servers (for example, `LDAPserver=pcintel6 p24709`) if either of the following is true:
  - The client is not located in the same domain forest as the Active Directory
  - The operating system does not have a directory service client (Windows NT and Windows 9X without installed `dsclient`).

For more information, see the SAP system profile parameter `ldap/servers`.
- For other directory services, you can use `LDAPnode` to specify the distinguished name of the SAP root node. For more information, see the SAP system profile parameter `ldap/saproot`.

**SAP MMC**

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. It is automatically set up when you install an SAP system on Windows. If the SAP system has been prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various sources, including the Active Directory.

Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MMC.

If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances both on Unix and Windows operating systems, you can also use the SAP MMC for operating and monitoring the instances running on Unix.

Note

You can also use the SAP Management Console (SAP MC) for administering and monitoring SAP systems from a central location. For more information about the SAP MC and about how to configure it to access LDAP directories, see the *SAP Library* page 4:

- Administrator’s Guide
- Technical Operations for SAP NetWeaver
- Administration of SAP NetWeaver Systems
- AS Java (Application Server Java)
- Administration
- Administration Tools
- SAP Management Console

**Configuration Tasks for LDAP Directories**

This section describes the configuration tasks you have to perform for the Active Directory or other (generic) LDAP directories.
2.5 Integration of LDAP Directory Services

Configuration Tasks for Active Directory

To enable an SAP system to use the features offered by the Active Directory, you must configure the Active Directory so that it can store SAP system data.

To prepare the directory, you use SAPinst to automatically:

- Extend the Active Directory schema to include the SAP-specific data types
- Create the domain accounts required to enable the SAP system to access and modify the Active Directory. These are the group SAP_LDAP and the user sap1dap.
- Create the root container where information related to SAP is stored
- Control access to the container for SAP data by giving members of the SAP_LDAP group permission to read and write to the directory

You do this by running SAPinst [page 68] and choosing: \Software Life-Cycle Options\ LDAP Registration \ Active Directory Configuration.

Note

You have to perform the directory server configuration only once. Then all SAP systems that need to register in this directory server can use this setup.

Configuration Tasks for Generic LDAP Directories

To configure other LDAP directories, refer to the documentation of your directory vendor. The SAPinst Installation Master DVD contains schema extensions for directory servers Netscape/Planet (1dregsns4.txt) and OpenLDAP slapd (1dregsldap.schema). Both files are located in the directory \DATA_UNITS\IM_<platform>\COMMON\ADS. After you have applied the schema extension, you need to create a root container to store the SAP-related information and create a directory user that the SAP application server can use to write information to the directory.

For more information about how to set up a Netscape/Planet directory server, see the documentation SAP System Information in Directory Services on SAP Service Marketplace at:

http://service.sap.com/msplatforms\Microsoft\Windows Server

Enabling the SAP System LDAP Registration

Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP system by setting some profile parameters in the default profile.

To do this, run SAPinst [page 68] once for your system and choose:

\Software Life-Cycle Options \ LDAP Registration \ LDAP Support

If you use a directory server other than Microsoft Active Directory and/or non-Windows application servers, you have to store the directory user and password information by using 1dappassword pf=<any_instance_profile>. The information is encrypted for storage in DIR_GLOBAL and is therefore valid for all application servers. After restarting all application servers and start services, the system is registered in your directory server. The registration protocols of the components are dev_ldap*. The registration is updated every time a component starts.
2.6 Implementation Considerations for MCOD

As described in *Installation of Multiple Components in One Database* [page 29], you can install additional components on one database. The following sections provide an overview of the changes that enable the installation of multiple components in one database.

**Different Schema for Database Objects**

To separate the different components in the DB2 subsystem, the database objects are owned by a component-specific authorization ID that is called *creator* or *schema* (these terms are identical). The default authorization ID used for both MCOD and non-MCOD installations is SAPR3. All database objects independent of whether they are installed as an additional or as the first component in the database subsystem are created by the authorization ID specified as *schema*. Make sure that all of the components use a different *schema*.

⚠️ **Recommendation**

We recommend that you use the SAP<SID> of the corresponding component, for example, SAPD6Z.

During the installation SAPInst sets an additional environment variable and profile parameter to the schema name as follows:

- `dbs_db2_schema` (environment variable)
- `dbs/db2/schema` (profile parameter)

**RACF Considerations**

Since additional authorization IDs are used in an MCOD landscape, you have to make sure that each schema used in your MCOD landscape is defined as a secondary authorization ID. For more information, see the *SAP Security Guide for IBM DB2 for z/OS*.

**Different Naming Convention for DB2 Stogroups — DB2 V8**

A stogroup name in a DB2 subsystem **must** be unique, even if the stogroups for additional components have a different owner. Therefore, the naming convention for the storage groups is as follows:

- `<SID><STOGROUP_ID>D`
- `<SID><STOGROUP_ID>I`

<STOGROUP_ID> is related to the table category, for example, LD for category LOAD.
Example

- Stogroup name for the master system (table category LOAD): SAPLDD and SAPLDI
- Stogroup name for additional components (table category LOAD, the schema used is SAPD6Z and the <SID> D6Z): D6ZLDD and D6ZLDI

Different Naming Convention for DB2 Stogroups – DB2 V9

DB2 V9 creates tablespaces and stogroups implicitly in DB2. Therefore, as of DB2 V9 there is only one default stogroup: SYSDEFLT.

2.7 Installation of Multiple Components in One Database

You can install multiple SAP systems in a single database. This is called Multiple Components in One Database (MCOD).

MCOD is available with all SAP components. This technology is available on all the major databases for the SAP system, in line with our commitment to deliver platform-independent solutions.

Using this technology is as easy as installing a separate component. No extra effort is required because the MCOD installation is fully integrated into the standard installation procedure. MCOD is not an additional installation option. Instead, it is an option of the database instance installation.

There are two MCOD scenarios:

- The installation of an SAP system in a new database
- The installation of an additional SAP system in an existing database

Prerequisites

- For about MCOD and its availability on different platforms, see http://service.sap.com/mcod.
- Since SAP does not support mixed solutions with MCOD, your SAP system must contain Unicode SAP instances only.
- Improved sizing required

In general, you calculate the CPU usage for an MCOD database by adding up the CPU usage for each individual SAP system. You can do the same for memory resources and disk space.

You can size multiple components in one database by sizing each individual component using the SAP Quick Sizer and then adding the requirements together. For about the SAP Quick Sizer, see http://service.sap.com/sizing.

Features

- Reduced administration effort
- Consistent system landscape for backup, system copy, administration, and recovery
Increased security and reduced database failure for multiple SAP systems due to monitoring and administration of only one database

- Independent upgrade
  In an MCOD landscape, you can upgrade a single component independently from the other components running in the same database, assuming that the upgraded component runs on the same database version. However, if you need to restore a backup, be aware that all other components are also affected.

**Note**

Special MCOD considerations and differences from the standard procedure are listed where relevant in the installation documentation.

**Constraints**

- We **strongly recommend** that you test MCOD in a test or development system. We recommend that you run MCOD systems in the same context. We do not recommend that you mix test, development, and production systems in the same MCOD.
- In the event of database failure, all SAP systems running on the single database are affected.
- Automated support in an MCOD landscape for the following administrative tasks depends on your operating system and database:
  - Copying a single component from an MCOD landscape to another database at database level.
  - De-installing a single component from an MCOD landscape requires some additional steps.
    You can use a remote connection to SAP support to request help with these tasks. For more information, see [http://service.sap.com/remoteconnection](http://service.sap.com/remoteconnection).
- For the first SAP system, the database system ID can be different from the SAP system ID.
- For the second SAP system, you must use the same **DBSID** as for the first SAP system.
- If you decide to turn off database logging during the database load phase of the installation, you need to plan downtime for all MCOD systems sharing the database.
3 Preparation

This section includes the preparation steps that you have to perform for the:

- Standard or high-availability system
- Additional application server instance
- Standalone host agent

**Standard, Distributed, or High-Availability System**

⚠️ Note
Since an SAP on IBM DB2 for z/OS system is always a distributed constellation, we only offer a **standard** or **high-availability** installation option.

1. You identify basic SAP system parameters [page 32].
2. You check the hardware and software requirements [page 39] on each host.
3. You check the Windows file system [page 56] on each host.
4. You check that all installation hosts belong to the correct Windows domain [page 56].
5. You reduce the size of the file cache [page 57] on each host.

⚠️ Note
This step is not required if you use Windows Server 2008.

6. You check that you have the required user authorization for the installation [page 58].
7. If required, you perform a domain installation without being a domain administrator [page 59].
8. If required, you prepare the SAP system transport host [page 62] for your SAP system.
9. You make sure that the required **installation media** [page 63] are available on each host.
10. You can now continue with Installation [page 67].

**Additional Application Server Instance**
You have to perform the following preparations on the host where you install the additional application server instance(s):

1. You check the hardware and software requirements [page 39].
2. You check the Windows file system [page 56].
3. You check that your host belongs to the correct Windows domain [page 56].
4. You reduce the size of the file cache [page 57].
3.1 Basic SAP System Parameters

SAPinst asks whether you want to run the installation in Typical or Custom mode.
If you choose Typical, SAPinst provides automatic default settings and you only have to respond to a minimum number of prompts. However, you can still change any of the default settings on the parameter summary screen.
The tables below list the basic system parameters that you always need to specify before installing your SAP system, both in typical and in custom mode.
For all other SAP system parameters, use the [F1] help in the SAPinst dialogs.
SAP System ID and Database ID

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System ID &lt;SAPSID&gt;</td>
<td>The SAP system ID &lt;SAPSID&gt; identifies the entire SAP system. SAPinst prompts you for the &lt;SAPSID&gt; when you execute the first installation option to install a new SAP system. If there are further installation options to be executed, SAPinst prompts you for the profile directory. For more information, see the description of the parameter SAP System Profile Directory.</td>
</tr>
</tbody>
</table>

Example
This prompt appears when you install the central services instance, which is the first instance to be installed in a distributed system.

Caution
Choose your SAP system ID carefully. Renaming is difficult and requires you to reinstall the SAP system.

Make sure that your SAP system ID:
- Is unique throughout your organization
- Consists of exactly three alphanumeric characters
- Contains only uppercase letters
- Has a letter for the first character
- Does not include any of the following, which are reserved IDs:
  - ADD ALL AND ANY ASC AUX COM CON DBA END EPS FOR GID IBM INT KEY LOG LPT MON NIX NOT NUL OFF OMS PRN RAW ROW SAP SET SGA SHG SID SQL SYS TMP UID USR VAR |
| System ID <SMDSID> of SAP Solution Manager Diagnostics Agent | SAPinst sets <SMDSID> to SMD by default. If SMD is already used by another SAP system that is not a Diagnostics Agent system, <SMDSID> is set to DA<<>, where <<> can be any letter from A to Z, and DA stands for “DiagnosticsAgent”). If required, you can change <SMDSID> to a value of your choice on the Parameter Summary screen. If you do so, the same naming conventions as for <SAPSID> apply. For more information, see entry “SAP System ID <SAPSID>” in this table above. |

SAP System Profile Directory

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\&lt;SAPGLOBALHOST&gt;\sapmnt&lt;SAPSID&gt;\SYS\profile</td>
<td>The installation retrieves the parameters entered earlier from the SAP system profile directory. SAPinst prompts you to enter the location of the profile directory when the installation option that you execute is not the first one belonging to your SAP system installation. See also the description of the parameters SAP System ID and Database ID.</td>
</tr>
</tbody>
</table>

Note
If you install an additional application server instance in an existing
### SAP System Instances, Hosts, and Ports

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Instance Number of the SAP system** | **Instance Number:** Technical identifier that is required for every instance of an SAP system, consisting of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. The instance number is used to specify the names of the SAP system instance directories which are created automatically by SAPInst during the installation:  
- The directory both of the primary application server instance and of an additional application server instance is called J<Instance_Number>.  
- The directory of the central services instance is called SCS<Instance_Number>. For more information, see *SAP Directories* [page 101]. |
| **Instance Number for the Diagnostics Agent** | Technical identifier for internal processes for the Diagnostics Agent, consisting of a two-digit number from 00 to 98. The instance number is set automatically to the next free and valid instance number that has not yet been assigned to the SAP system. The instance number is used to specify the name of the Diagnostics Agent instance directory which are created automatically by SAPInst during the installation:  
The directory of the Diagnostics Agent instance is called J<Instance_Number>. For more information, see *SAP Directories* [page 101]. The same restrictions apply as in “Instance Number of the SAP system” (see above). |
## 3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Host Name</td>
<td>You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to order to conceal their physical network identities from each other. This may be useful when moving SAP servers or complete server landscapes to other new hardware within a short time frame without having to carry out a reinstallation or complicated reconfiguration. If you want to use virtual host names for the installation, you have to specify the virtual host name before you <code>start SAPinst [page 68]</code>. Virtual host names are also required for a <strong>high-availability (HA) system</strong>. You need to specify the virtual host name, which is used by the (A)SCS instance. ▶ For more information about the use of virtual TCP/IP host names, see SAP Note <a href="https://support.sap.com">962955</a>. ▶ The host name must not exceed 12 characters. For more information about the allowed host name length and characters, see SAP Note <a href="https://support.sap.com">611361</a>.</td>
</tr>
</tbody>
</table>
| Message Server Port | **⚠️ Caution**<br>The message server port number must be unique for the SAP system on all hosts. If there are several message port numbers on one host, all must be unique.  
**Port Number of the SAP Message Server:**<br>If you do not specify a value, the default port number is used. The SCS instance profile contains the configuration for the Java message server. The Java message server port uses the parameter `rdisp/msserv_internal` with default value `39<nn>`, where `<nn>` is the instance number of the SCS message server instance. For more information about the parameters used for message server ports, see SAP Note [821875](https://support.sap.com). |
| Master Password      | **⚠️ Caution**<br>This password is used for all new user accounts SAPinst creates and for the secure store key phrase. The length has to be 8 to 14 characters. Depending on your installation scenario there might be more restrictions.  
If you do not create the operating system users manually, SAPinst creates them with the common master password. For more information, see the description of the parameter *Operating System Users*. In this case, make sure that the master password meets the requirements of your operating system and of your database. |
Operating System Users of the SAP System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Password of Operating System Users** | SAPInst processes the passwords of operating system users as follows:  
- If the operating system users do **not** exist, SAP creates the following users:  
  - `<sapsid>adm`
    This user is the SAP system administrator user and is a member of the local **Administrators** group.  
  - `SAPService<sapsid>`
    This user is the Windows account to run the SAP system. It is not a member of the local **Administrators** group.  
  - `sapadm`
    The host agent user `sapadm` is used for central monitoring services and is a member of the local **Administrators** group.  
  - `**sys`  
    SAPInst sets the master password for these users by default. You can overwrite and change the passwords either by using the parameter mode `Custom` or by changing them on the parameter summary screen.  
- If the operating system users already exist, SAPInst prompts you for the existing password, except the password of these users is the same as the master password. |

**Caution**  
Make sure that you have the **required user authorization** [page 58] for these accounts before you start the installation.

User Management Engine (UME)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| **UME Configuration** | SAPInst prompts you for how to configure the UME during the input phase of the installation.  
You can choose between the following options:  
- Use Java database (default).  
  - If you choose this option, administrators can manage users and groups with the **UME Web admin tool** and **SAP NetWeaver Administrator** only.  
- Use an external ABAP system.  
  - If you choose this option, administrators can manage users with the transaction SU01 on the external ABAP system, and, depending on the permissions of the communication user, also with the **UME Web admin tool** and **SAP NetWeaver Administrator**.  
You must have created the required users manually on the external ABAP system.  
For more information, see **Preparing User Management for an External ABAP System** [page 53].  
For more information about supported UME data sources and change options, see **SAP Note 718383**. |

Using the Java Database:
### 3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Administrator User</td>
<td>SAPinst sets the user name <em>Administrator</em> and the master password by default. If required, you can choose another user name and password according to your requirements.</td>
</tr>
<tr>
<td>Java Guest User</td>
<td>SAPinst sets the user name <em>Guest</em> and the master password by default. The <em>Guest</em> user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group <em>Authenticated Users</em> and have read access only.</td>
</tr>
</tbody>
</table>

### Using an External ABAP System – Parameters for the ABAP Connection:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server Instance Number</td>
<td>This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java. To find out the number on the host of the primary application server instance, look under the SAP directory <code>usr/sap/&lt;SAPSID&gt;/DVEBMGS&lt;nn&gt;</code> The value <code>&lt;nn&gt;</code> is the number assigned to the SAP system.</td>
</tr>
<tr>
<td>Application Server Host</td>
<td>This is the host name of the relevant application server instance. To find out the host name, enter <code>hostname</code> at the command prompt of the host running the primary application server instance.</td>
</tr>
<tr>
<td>Communication User</td>
<td>This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.</td>
</tr>
</tbody>
</table>

### Using an External ABAP System – Parameters for the Application Server Java Connection:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator User</td>
<td>This is the name and password of the administrator user that you created on the external ABAP system.</td>
</tr>
<tr>
<td>Administrator Role</td>
<td>The role <code>SAP_J2EE_ADMIN</code> must exist on the external ABAP system.</td>
</tr>
<tr>
<td>Guest User</td>
<td>This is the name and password of the guest user that you created on the external ABAP system. The guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group <em>Authenticated Users</em> and have read access only.</td>
</tr>
<tr>
<td>Guest Role</td>
<td>The role <code>SAP_J2EE_GUEST</code> must exist on the external ABAP system.</td>
</tr>
</tbody>
</table>

### Key Phrase for Secure Store Settings

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Key Phrase for Secure Store Settings | This is a random word or phrase that is used to encrypt the secure store. The Java EE engine uses this phrase to generate the key that is used to encrypt the data. The uniqueness of the phrase you use contributes to the uniqueness of the resulting key. │

**Recommendation**

Use a long key phrase that cannot be guessed easily. Use both uppercase and lowercase letters in the phrase and include special characters.
### Internet Communication Manager (ICM) User Management

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <code>webadm</code></td>
<td>The administration user <code>webadm</code> is created to use the web administration interface for Internet Communication Manager (ICM) and Web Dispatcher. SAPinst sets the master password by default. If required, you can choose another password. The length of the password must be between 5 and 128 characters.</td>
</tr>
</tbody>
</table>

### Host Agent

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <code>sapadm</code></td>
<td>The administration user <code>sapadm</code> is created to use central monitoring services. If this user does not already exist, SAPinst automatically creates it. SAPinst prompts you to enter either the password of the existing user or a new password for the user to be created.</td>
</tr>
</tbody>
</table>

### Solution Manager Key

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Solution Manager key</td>
<td>To install your SAP system, you need to generate an SAP Solution Manager key <a href="#">page 63</a>, which the installation requires to continue. For more information, see SAP Note 805390.</td>
</tr>
</tbody>
</table>

### Parameters Relevant for the Database

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Name of DB2 Subsystem (DDF) and Port (DDF)</td>
<td>Contact your DB2 for z/OS database administrator to determine the location name and port. The administrator enters the command <code>-DISPLAY DDF</code>. The output shows the parameters <code>LOCATION</code> and <code>TCPPORT</code>, and their values are listed directly below them.</td>
</tr>
<tr>
<td>Volumes Catalog Identifier (VCAT)</td>
<td>Volumes Catalog Identifier (VCAT) is the high-level qualifier of the DB2 datasets.</td>
</tr>
<tr>
<td>Database Schema for Java</td>
<td>The default is <code>SAPJAVA</code>. This is relevant for MCOD Java and ABAP+Java systems. The schema you specify must be an existing user ID on the database server.</td>
</tr>
<tr>
<td>Database Administrator User ID</td>
<td>Valid user ID on the database server with <code>SYSADM</code> privileges on the DB2 subsystem on which you would like to install your SAP system. This user ID is only necessary for the installation process.</td>
</tr>
</tbody>
</table>
### 3.2 Hardware and Software Requirements

You check that your hosts meet the hardware and software requirements for your operating system and the SAP instances.

**Caution**

If your hosts do not fully meet the requirements, you might experience problems when working with the SAP system.

**Prerequisites**

- Contact your OS vendor for the latest OS patches.
- Make sure that the host name meets the requirements listed in [SAP Note 611361](http://support.sap.com/notes).  
- If you have any questions, contact the person in charge of the installation, your Competence Center, or your local IBM representative.
Process Flow

1. Check the Product Availability Matrix at [http://service.sap.com/pam](http://service.sap.com/pam) for supported operating system releases.

2. Check the hardware and software requirements using:
   - **The Prerequisite Checker:**
     - Standalone (optional) before the installation process
       - For more information, see Running the Prerequisite Checker Standalone [page 41].
     - Integrated in the installation tool (mandatory) as part of the installation process
       - For more information, see Running SAPinst [page 68].

   [Note]
   For the most recent updates to the Prerequisite Checker, always check SAP Note 855498.

   - The hardware and software requirements checklists for:
     - Standard system [page 42]
     - Additional application server instance
       - If you want to install an additional application server instance, check the requirements listed for a standard system [page 42] or high-availability system [page 43], depending on your system architecture.
     - High-availability system [page 43]
     - Application Sharing Server as an Optional Standalone Unit
       - If you want to install the Application Sharing Server as a standalone unit, you must meet the same requirements as for a Java standard system [page 42].
     - Standalone host agent [page 51]

3. If you are installing a production system, the values provided by the Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In addition, do the following:
     - For more information about the SAP Quick Sizer and available sizing guides, see the Master Guide – SAP NetWeaver 7.0 at [http://service.sap.com/installnw70](http://service.sap.com/installnw70) Planning 4).
   - You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
     - The set of applications to be deployed
     - How intensively the applications are to be used
3.2 Hardware and Software Requirements

- The number of users

### 3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)

Before installing your SAP system, you can run the Prerequisite Checker in standalone mode to check the hardware and software requirements for your operating system (OS) and the SAP instances.

#### Recommendation

We recommend that you use both the Prerequisite Checker and the requirements tables for reference.

#### Note

When installing your SAP system, SAPinst automatically starts the Prerequisite Checker and checks the hardware and software requirements in the background.

#### Prerequisites

- You have prepared the Installation Master DVD on the required installation host [page 63].

#### Procedure

1. You start SAPinst [page 68].
2. On the Welcome screen, choose <SAP System> > Software Life-Cycle Options > Additional Preparation Tasks > Prerequisites Check.
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.

#### Note

For more information about each parameter, position the cursor on the parameter field and choose [F1] in SAPinst.

When you have finished, the Parameter Summary screen appears summarizing all parameters you have entered. If you want to make a change, select the relevant parameters and choose Revise.

4. To start the Prerequisite Checker, choose Start.

#### Result

The Prerequisite Check Results screen displays the results found. If required, you can also check the results in file prerequisite_checker_results.html, which you can find in the installation directory.
## 3.2.2 Requirements for a Standard System

If you want to install a standard system in which all instances reside on one host (except for the database instance [page 46]), this host must meet the following requirements:

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>SAP system files (not including paging file): 5 GB (x64)</td>
<td>To check disk space:</td>
</tr>
<tr>
<td></td>
<td>8 GB (IA64)</td>
<td>1. Choose 📀 Start 📀 All Programs 📀 Administrative Tools 📀 Computer Management 📀 Disk Management.</td>
</tr>
<tr>
<td></td>
<td>Up to 2 GB for each usage type or software unit you want to install.</td>
<td>2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td></td>
<td>4.3 GB of temporary disk space for every required installation DVD that you</td>
<td></td>
</tr>
<tr>
<td></td>
<td>have to copy to a local hard disk</td>
<td></td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>2 GB</td>
<td>To check RAM:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the Windows Explorer, choose 📀 Help 📀 About Windows.</td>
</tr>
<tr>
<td>Paging file size</td>
<td>1 times RAM plus 14 GB</td>
<td>To check paging file size:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. If required, in section Virtual memory, choose Change.</td>
</tr>
<tr>
<td>DVD drive</td>
<td>DVD drive locally connected to the host running the primary application server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>instance</td>
<td></td>
</tr>
</tbody>
</table>
Software Requirements for a Standard System

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Windows operating system | English international 64-bit version of one of the following Windows Server Editions:  
  - Windows Server 2003  
    - Windows Server 2003 Enterprise Edition  
    - Windows Server 2003 Datacenter Edition  
  - Windows Server 2008  
    - Windows Server 2008 Standard Edition  
    - Windows Server 2008 Enterprise Edition  
    - Windows Server 2008 Datacenter Edition  
    - Windows Server 2008 for Itanium-Based Systems Edition  
  
  **Caution**  
  When this guide was published, Windows Server 2008 had not yet been released for your SAP system.  
  For up-to-date information on the released operating system versions for your SAP product and database, see the Product Availability Matrix (PAM) at [http://service.sap.com/pam](http://service.sap.com/pam).  
  - For any version of Windows Server, you need the latest supported service pack.  
  - A suitable Windows Resource Kit is strongly recommended. | To check your Windows version:  
  1. Choose Start All Programs Accessories Command Prompt.  
  2. Enter the command `winver`. |

More Information

- Requirements for z/OS [page 46]  
- Requirements for DB2 for z/OS [page 48]  
- Necessary z/OS Group and User IDs [page 50]

### 3.2.3 Requirements for a High Availability System

In this section you can find the hardware and software requirements that you need to fulfill for your Windows application server when you install a high availability system for SAP on DB2 for z/OS.
Preparation

3.2 Hardware and Software Requirements

Note

- The values are only valid for development or quality assurance systems.
- These requirements are valid if you install one instance per host.

Caution

If you install several SAP instances on one host, you need to add up the requirements for all instances.

Integration

Hardware Requirements for a High-Availability System

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>- Central services instance (SCS) (not including paging file): 5 GB (x64) 8 GB (IA64) - Enqueue replication server instance (ERS) (not including paging file): 5 GB (x64) 8 GB (IA64) - Primary application server instance (not including paging file): 2.5 GB (x64) 5 GB (IA64) - In addition you require 4 GB (x64), or 8 GB (IA64) per additional platform. - Up to 2 GB for each usage type or software unit you want to install. - Additional application server instance (not including paging file): 2.5 GB (x64) 5 GB (IA64) - Temporary disk space for every required installation DVD that you have to copy to a local hard disk: 4.3 GB</td>
<td>To check disk space: 1. Choose Start All Programs Administrative Tools Computer Management Disk Management. 2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
<td>To check RAM: In the Windows Explorer, choose Help About Windows.</td>
</tr>
</tbody>
</table>
### Hardware and Software Requirements

#### Software Requirements for a High-Availability System

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td><strong>English international 64-bit version</strong> of one of the following Windows Server Editions:</td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td></td>
<td>◆ Windows Server 2003 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◆ Windows Server 2008</td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>◆ Windows Server 2008 Enterprise Edition</td>
<td>You must set up the MSCS Cluster Service as described in the Microsoft</td>
</tr>
<tr>
<td></td>
<td>◆ Windows Server 2008 Datacenter Edition</td>
<td>documentation. During this setup you are asked for a Windows Domain Account</td>
</tr>
<tr>
<td></td>
<td>◆ Windows Server 2008 for Itanium-Based Systems Edition</td>
<td>to run the Cluster Service. We strongly recommend creating an account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>different from the <code>&lt;sapsid&gt;adm</code> user, for example <code>ClusterServiceuser=sapprdc1adm</code>,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>where <code>Clustername=sapprdc1</code>.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong></td>
<td>For up-to-date information on the released operating system</td>
</tr>
<tr>
<td></td>
<td>When this guide was published, Windows Server 2008 had not yet been</td>
<td></td>
</tr>
<tr>
<td></td>
<td>released for your SAP system.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Windows Server 2008 only:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>You must add the operating system feature <code>Failover Clustering</code> on</td>
</tr>
</tbody>
</table>

#### Hardware Requirement

<table>
<thead>
<tr>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paging file size</td>
<td>To check paging file size:</td>
</tr>
<tr>
<td></td>
<td>4. If required, in section Virtual memory, choose Change.</td>
</tr>
</tbody>
</table>

**Note**
You must adjust the size of the paging file on all MSCS nodes.
## 3.2.4 Requirements for z/OS

The information in this section is provided to help you fulfill the minimum requirements on z/OS. The following table lists the requirements for the database instance in a standard system installation with an application server on AIX, Linux or Windows and for a SAP central services installation on z/OS.

### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>IBM System z capable of supporting z/OS Version 1.7 or higher. The supported operating system releases are listed in the SAP Service Marketplace at <a href="http://service.sap.com/platforms">http://service.sap.com/platforms</a>.</td>
</tr>
<tr>
<td>Disk Space</td>
<td>At least 60 GB disk space (DASD) exclusively for the database.</td>
</tr>
<tr>
<td>Real memory for z/OS</td>
<td>For production systems, at least 400 MB plus 200 MB for each SAP system, configured as central storage. For non-production systems, at least 150 MB plus 50 MB for each SAP system.</td>
</tr>
</tbody>
</table>
Software Requirements

### Operating System-related Software

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>z/OS, Version 1.7 or higher with the following components installed:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UNIX System Services</td>
</tr>
<tr>
<td></td>
<td>DFSMS</td>
</tr>
<tr>
<td></td>
<td>TCP/IP</td>
</tr>
<tr>
<td></td>
<td>LE/370</td>
</tr>
<tr>
<td></td>
<td>DFSORT</td>
</tr>
<tr>
<td></td>
<td>Security Server (RACF or equivalent product)</td>
</tr>
<tr>
<td></td>
<td>JES2 or JES3 installed and configured.</td>
</tr>
<tr>
<td></td>
<td>RMF or another compatible product that supports the Sysplex Data Services (ERBDSQRY, ERBDSREC, ERB2XDG, ERB3XDRS) installed for saposco1 for z/OS.</td>
</tr>
<tr>
<td></td>
<td>z/OS RRS installed and set up. For more information, see <a href="http://service.sap.com/RRS">SAP Planning Guide: DB2 for z/OS Setting Up Resource Recovery Services (RRS)</a>.</td>
</tr>
<tr>
<td></td>
<td>z/OS Unicode Conversion Services (UCS) and appropriate conversion definitions need to be set up for your environment. For more information, see the IBM DB2 documentation and Information APARs II13048, II13049, II13277, II13695.</td>
</tr>
</tbody>
</table>

#### Note

The supported operating system releases are listed on [SAP Service Marketplace](http://service.sap.com/platforms).

### APARs and PTFs

- Required APARs:
  - Obtain the SAP Note number for the list of required APARs from [SAP Note 81737](http://service.sap.com/81737).
  - Ask your system programmer whether all PTFs for these APARs have been installed.
- Set up the PTF check tool, which automatically checks installed PTFs. Refer to [SAP Note 183311](http://service.sap.com/183311).

### FTP Server

FTP server installed and configured (REGION=ON for the installation): Issue `ftp<db_host>` on an application server, where `<db_host>` is the z/OS host name.

### Additional Requirements and Settings

#### Note

For more information about z/OS prerequisites, see [SAP Planning Guide: DB2 for z/OS](http://service.sap.com/DB2zOS).

### Recommended DB2 Settings

The recommended DB2 settings are listed in the SAP documentation [SAP DBA Guide: DB2 for z/OS](http://service.sap.com/DB2zOS). These initial values are recommended if the DB2 subsystem is used exclusively for the SAP system. As a result of monitoring the DB2 performance, you might need to change some of the values.

### Logging

We recommend that you employ dual logging. DB2 logs for installation must tolerate up to 2 GB/hour. Archiving is required, and there must be at least 20GB of archiving space. Most of this space can be reclaimed after the SAP system on DB2 is up and running. The preferred archiving medium is
disk, with tape silos representing the second-most preferred medium. If there is a lack of volume space, warnings are written to the z/OS console.

Note

DB2 stops if it cannot perform logging, for example, due to a lack of volume space.

DB2 Subsystem Installation Check

1. Verify that the DB2 subsystem is running by executing the following command from TSO:
   
   ```
   dsn system (<Database Attach Name>)
   ```

2. If the subsystem is accessible, this command calls the DB2 command processor. Otherwise, an error message is displayed.

3. To leave the DB2 command processor, use the command: END.

### 3.2.5 Requirements for DB2 for z/OS

The following are database-related requirements that must be fulfilled for your SAP system on IBM DB2 for z/OS:

Note

These requirements apply to all instances, except for the central services instance.

#### Requirements for DB2 for z/OS

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
</table>
| Database to Application Server Connection | You need to have a connection between the application server on Windows and the database server.  
For more information, see [SAP Planning Guide: DB2 for z/OS](http://www.ibm.com/servers/eserver/zseries/software/sap/docu.html).  
See also the IBM documentation site at [IBM](http://www.ibm.com/servers/eserver/zseries/software/sap/docu.html). |
| Database-related software          | - DB2 for z/OS, Version 8 or Version 9 installed. DDF (Distributed Data Facility) is configured. For more information, see [SAP DBA Guide: DB2 for z/OS](http://www.ibm.com/servers/eserver/zseries/software/sap/docu.html)  

Note

If you are using DB2 for z/OS Version 9, you must use z/OS Version 1.7.  
- DB2 Utilities Suite for z/OS  
- Control Center for DB2 for z/OS (FMID JDB881D)  
- Workload manager (WLM) set up for DB2 stored procedures installed. For more information, see [SAP DBA Guide: DB2 for z/OS](http://www.ibm.com/servers/eserver/zseries/software/sap/docu.html)  
### Requirement | Description
--- | ---
**CLI and JDBC Drivers** | The CLI and JDBC Drivers are installed automatically by SAPInst. However, you need to obtain a license for these products, since the delivered license is only valid for 90 days. To install the license:
1. If you are an OEM customer, you can download the license from [http://service.sap.com/swcenter-3pmain](http://service.sap.com/swcenter-3pmain) > DB2 for z/OS > License Files for IBM DB2 Connect V9.x.
2. If you are an IBM customer, contact your IBM representative.
3. When you have the license, copy it to the license directory `<drive letter>:\usr\sap\<SID>\<INSTANCE>\exe\db2_clidriver\license`.

| JDBC License | If your SAP system is Java-only, you need to obtain the JDBC license **before** you install your SAP system. To install the license:
1. If you are an OEM customer, you can download the license from [http://service.sap.com/swcenter-3pmain](http://service.sap.com/swcenter-3pmain) > DB2 for z/OS > License Files for IBM DB2 Connect V9.x.
2. If you are an IBM customer, contact your IBM representative. |

---

**Additional Requirements and Settings**

**Recommended DB2 Settings**

Recommended DB2 settings are listed in the SAP documentation *SAP DBA Guide: DB2 for z/OS*. These initial values are recommended if the DB2 subsystem is used exclusively for the SAP system. You might need to change some of the values after monitoring DB2 performance.

**Logging**

We recommend that you employ dual logging. DB2 logs for installation must tolerate up to 2 GB/hour. Archiving is required, and there must be at least 20GB of archiving space. Most of this space can be reclaimed after the SAP system on DB2 is up and running. The preferred archiving medium is disk, with tape silos representing the second-most preferred medium. If there is a lack of volume space, warnings are written to the z/OS console.

| Note | DB2 stops if it cannot perform logging, for example, due to a lack of volume space. |

**DB2 Subsystem Installation Check**

1. Verify that the DB2 subsystem is running by executing the following command from TSO:
   
   ```
dsn system (<Database Attach Name>)
   ```
2. If the subsystem is accessible, this command calls the DB2 command processor. Otherwise, an error message is displayed.

3. To leave the DB2 command processor, use the command: **END.**

Connection to the Database Server

After the central instance has been installed, you need to check the connection to the database server:

1. Log on as `<sapsid>adm.`

2. Enter the following command:

   ```bash
   R3trans -x
   ```

   The return code should be 0 (zero). This indicates that all connections are working.
   - If the return code is greater than 0, check that your database was started and check the connection again with `R3trans`.
   - If that still fails, check your environment variable settings, which is listed in the output of `R3trans`.

   The output of `R3trans` is written to the `trans.log` file.

### 3.2.6 Necessary z/OS Group and User IDs

The following is a list of the z/OS group and z/OS user IDs necessary for your system. If these group or user IDs do not already exist in your system, you must create them. For more information, see *SAP Security Guide for IBM DB2 for z/OS* > **Security Settings for z/OS**.

**Note**

For each group and user, you must create an entry in the table `/etc/uuidstable`, to ensure that each group and user can be used in both upper and lowercase.

<table>
<thead>
<tr>
<th>Group/User ID</th>
<th>Description</th>
<th>Usage Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB Connect User ID for AS Java</td>
<td>Permanent user needed for the database connection. You are free to choose the name of this user. If you are installing both usage types, we advise you to choose different names for the user IDs for AS ABAP and AS Java.</td>
<td>AS Java</td>
</tr>
<tr>
<td>Group ID for Java Schema</td>
<td>Permanent group needed for the Java schema. This group ID must be the same as the name of the Java schema that you specify during installation. If you are installing both usage types, we advise you to choose different names for the group IDs for ABAP schema and Java schema.</td>
<td>AS Java</td>
</tr>
</tbody>
</table>
3.2 Hardware and Software Requirements

Users and Their Primary Groups for the Host Agent

Note
This user is only necessary when you install an ASCS or SCS instance on z/OS.

Users and Groups of the SAP System

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
<th>Additional Group</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapadm</td>
<td>sapsys</td>
<td>sapinst</td>
<td>Host Agent administrator</td>
</tr>
</tbody>
</table>

3.2.7 Requirements for the Additional Application Server Instance

More Information
For more information about the requirements for the additional application server instance(s), see either
Requirements for a Standard System [page 42] or Requirements for a High-Availability System [page 43], depending on the architecture of your SAP system.

3.2.8 Requirements for the Host Agent as a Separate Installation

If you want to install the host agent separately, the installation host has to meet the following requirements:

Hardware Requirements for the Host Agent

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space:</td>
<td>C Host agent: 80 MB</td>
<td>To check disk space:</td>
</tr>
<tr>
<td></td>
<td>C Temporary disk space for every required installation DVD that you have</td>
<td>1. Choose [Start] [All Programs] [Administrative Tools] [Computer Management] [Disk Management].</td>
</tr>
<tr>
<td></td>
<td>have to copy to a local hard disk: 4.3 GB</td>
<td>2. Right-click the drive and choose Properties.</td>
</tr>
</tbody>
</table>
### 3.2 Hardware and Software Requirements

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum RAM:</td>
<td>40 MB</td>
<td>To check RAM: In the Windows Explorer choose Help &gt; About Windows.</td>
</tr>
</tbody>
</table>
| Paging file size:    | 500 MB      | To check paging file size:  
4. If required, in section Virtual memory, choose Change. |

#### Software Requirements for the Host Agent

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Windows operating system: | **English international 64-bit version** of one of the following Windows Server Editions:  
- Windows Server 2003  
  - Windows Server 2003 Enterprise Edition  
  - Windows Server 2003 Datacenter Edition  
- Windows Server 2008  
  - Windows Server 2008 Enterprise Edition  
  - Windows Server 2008 Datacenter Edition  
  - Windows Server 2008 for Itanium-Based Systems Edition | To check your Windows version:  
1. Choose Start > All Programs > Accessories > Command Prompt.  
2. Enter the command `winver`. |

**Caution**

When this guide was published, Windows Server 2008 had not yet been released for your SAP system. For up-to-date information on the released operating system versions for your SAP product and database, see the Product Availability Matrix (PAM) at
### Software Requirement

<table>
<thead>
<tr>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>

- For any version of Windows Server, you need the latest supported service pack.
- A suitable Windows Resource Kit is strongly recommended.

---

## 3.3 Preparing User Management for an External ABAP System

For a Java system, you can also deploy user management for an external ABAP system. In this case, you configure the User Management Engine (UME) of Application Server Java (AS Java) for the user management of a separate ABAP system.

If you want to connect more than one Java system to the same ABAP system, you need to work out a concept for the communication, administrator, and guest users for each system.

You can take one of the following approaches:

<table>
<thead>
<tr>
<th>Approach</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Java system uses different users</td>
<td>No interdependencies between the connected engines</td>
<td>Initially more administration to create the users in the ABAP system</td>
</tr>
</tbody>
</table>
| All Java systems use the same configuration | You create the users only once and enter the same information for every Java systems that you install. | Interdependencies between the connected engines:  
- If you change the password of any of the users on the ABAP system, this change affects all connected engines.  
- If you change the administrator user’s password, you must also change the password in secure storage on all of the connected Java systems |

↑ Recommendation

For security reasons, we recommend the first approach.
The procedures below assume that you are using the first approach.

**Prerequisites**

- The ABAP system is based on at least SAP Web AS ABAP release 6.20 SP25.
- In transaction PFCG, check that the roles `SAP_BC_JSF_COMMUNICATION` and `SAP_BC_JSF_COMMUNICATION_R0` exist and make sure that their profiles are generated.
- In transaction PFCG, check that the roles `SAP_J2EE_ADMIN`, `SAP_J2EE_GUEST` and `SAP_BC_FP_ICF` exist. Neither role contains any ABAP permissions, so you do not need to generate any profiles.
- For more information, see the *SAP Library* [page 14]:
  - Function-Oriented View  Security  Identity Management  Identity Management of the Application Server Java
  - User Management Engine

**Note**

For more information about role maintenance, see the *SAP Library* [page 14] at

- Function-Oriented View  Security  Identity Management  Identity Management of the Application Server ABAP
- AS ABAP Authorization Concept

**Administration of the ABAP system**

Perform the following administration steps in the **ABAP** system:

1. In transaction SU01, create a new communication user and assign it to the role `SAP_BC_JSF_COMMUNICATION_R0`.

   **Recommendation**

   We recommend that you assign this user the role `SAP_BC_JSF_COMMUNICATION_R0` for read-only (display) access to user data with Java tools. If you intend to maintain user data (that is, to change, create, or delete users) with Java tools, you need to assign the role `SAP_BC_JSF_COMMUNICATION` instead.

   We recommend that you name the user `SAPJSF_<SAPSID_Java_System>`.

   You can use any password.

   In addition, to make sure that this user can only be used for communication connections between systems and not as a dialog user, assign it the type *Communications* under *Logon data*.

2. In transaction SU01, create a new dialog user and assign it to role `SAP_J2EE_ADMIN`. This is your administrator user in AS Java.

   **Recommendation**

   We recommend that you name the user `J2EE_ADM_<SAPSID_Java_System>`. You can use any password.
3 In transaction SU01, create a new dialog user and assign it to role SAP_J2EE_GUEST. This is your guest user in AS Java.

**Recommendation**
We recommend that you name the user J2EE_GST_<SAPSID_Java_System>. You can use any password. Since this user is only used for anonymous access to the system, we recommend you to deactivate the password and, if required, lock it after installation to prevent anyone from using it for explicit named logons.

4 In transaction SU01, create the following dialog users:

**Caution**
You must have changed the initial passwords of these users before you start the installation of the Java system.

- **Users for Adobe Document Services (ADS) (optional):**
  - **ADSUSER:**
    In transaction PFCG, assign the role ADSCallers to this user.
  - **ADS_AGENT:**
    In transaction PFCG, assign the role SAP_BC_FP_ICF to this user.

- **SLD Data supplier user (optional):**
  You only have to create this user if you want to install System Landscape Directory (SLD). The SLD data supplier user name that you enter later on during the Java system installation must be identical to this user.

  **Recommendation**
  We recommend that you name this user SLDDSUSER

- **SLD ABAP API user (optional):**
  You only have to create this user if you want to install System Landscape Directory (SLD). The SLD ABAP API user name that you enter later on during the Java system installation must be identical to this user.

  **Recommendation**
  We recommend that you name this user SLDAPIUSER
Activities for the Java System
Perform the following steps in the Java system:

1. **Before** the installation of the Java system, make sure that you have the correct user names and passwords of the users listed above for the separate ABAP system.
2. **During** the installation of the Java system, make sure that you enter the correct users and passwords in the corresponding SAPInst dialogs.

3.4 Checking the Windows File System

You need to check that you are using the Windows file system NTFS on hosts where you want to install the SAP system. NTFS supports full Windows security and long file names.

**Note**
You must use NTFS for an SAP system installation. Do not install the SAP directories on a FAT partition.

**Procedure**

1. Open the Windows Explorer.
2. Select the relevant disk
   The system displays the type of file system in use.
4. Check that the file system is NTFS.

3.5 Checking the Windows Domain Structure

**Note**
You do not need this step for a local installation.

In Windows, you can implement either of the following domain models for the SAP system:

- **Extra domain**
  In this model, the SAP system is embedded in its own domain, which is specially defined for SAP. A second domain exists for the user accounts.
In Windows, the SAP domain and user domain must be incorporated in a domain tree. In this tree, the user accounts must form the root domain and the SAP domain must be a child domain of this.

- **Single domain**
  In this model, the SAP system and the user accounts are included in a single domain.

**Prerequisites**

- You are performing a domain installation.
- You are familiar with checking Windows domain structures. For more information, see the Windows documentation.

**Caution**
You cannot create local users and groups on the host that is used as domain controller. Therefore, we do **not** support running an SAP instance on the host where the domain controller is installed.

**Procedure**
For a domain installation, we recommend that you check that all SAP system hosts are members of a single Windows domain. We recommend this for all SAP system setups.

### 3.6 Reducing the Size of the File Cache

**Note**
This step is not required if you use Windows Server 2008.

The Windows file cache competes directly with SAP programs for memory. Therefore, you need to adjust the file cache as described below.

**Procedure**

1. Choose **Start** ➤ **Control Panel** ➤ **Network Connections** ➤ **Local Area Connections** ➤
2. In the **Local Area Connection Status** dialog box, choose **Properties**.
3. In the **Local Area Connection Properties** dialog box, double-click **File and Printer Sharing for Microsoft Networks**.
4. Select **Maximize data throughput for network applications**.

**Caution**
If you cannot select **File and Printer Sharing for Microsoft Networks**, this option has not yet been installed. To install it, you need the Windows Server CDs.

5. To confirm your entries, choose **OK**.
3.7 Required User Authorization for the Installation

Although SAPinst automatically grants the rights required for the installation to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a domain or local installation. If necessary, you have to ask the system administrator to grant the account the necessary authorization before you start the installation. If you attempt the installation with an account that does not have the required authorization, the installation aborts.

This section informs you about the authorization required for a domain and a local installation.

⚠ Caution
Do not use the user <sapsid>adm for the installation of the SAP system.

Domain Installation
For a domain installation the account used for the installation needs to be a member of the local Administrators and the domain Admins group of the relevant domain. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.

⚠ Caution
- If you still want to perform a local installation for a distributed system, make sure that:
  - You use the same master password on all hosts.
  - All hosts belong to the same Windows work group.
- For performance and security reasons, SAP does not support an SAP system installation on a domain controller.
- If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. However, the domain administrator has to prepare the system appropriately for you.
  
  For more information, see Performing a Domain Installation without being a Domain Administrator [page 59].

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain Admins group.
**Local Installation**

For a local installation the account used for the installation needs to be a member of the local Administrators group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local Administrators group.

---

**3.8 Performing a Domain Installation Without Being a Domain Administrator**

You normally perform a domain installation of the SAP system with a user who is a member of the domain Admins group, as described in Required User Authorization for the Installation [page 88]. If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the domain administrator has to prepare the system appropriately for you. The domain administrator can perform the following steps either using SAPinst or manually:

1. Create the new global group SAP_<SAPSID>_GlobalAdmin.
2. Add the users <sapsid>adm and SAPService<SAPSID> to the newly created group SAP_<SAPSID>_GlobalAdmin.

**Prerequisites**

- You must be domain administrator to perform the required steps.
- **Windows Server 2008 only:**
  - You must have installed the feature Remote Server Administration Tools as follows:
    2. In the Server Manager windows, select Features.

**Creating the Required Uses and Groups Using SAPinst**

On the host where the SAP system is to be installed, the domain administrator runs SAPinst [page 68] and chooses ➤ Software Life-Cycle Options ➤ Additional Preparation Options ➤ Operating System and Users ➤ to have the group and users created automatically.
Creating the Required Uses and Groups Manually

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin

1. Log on as domain administrator.
2. To start the Active Directory Users and Computers Console, choose:
   - Start ➜ Control Panel ➜ Administrative Tools ➜ Active Directory Users and Computers ➜

   **Note**
   **Windows Server 2003 only:** If you cannot find Active Directory Users and Computers, start it as follows:
   a) Choose Start ➜ Run ➜ and enter mmc.
   b) Choose Console ➜ Add/Remove Snap-in... ➜ Add ➜
   c) Select Active Directory Users and Computers.
   d) Choose Add ➜
   e) Choose Close ➜ OK ➜

3. Right-click Users in Tree, and choose ➜ New ➜ Group ➜
4. Enter the following:
   - Group name: SAP_<SAPSID>_GlobalAdmin

   **Note**
   Enter the SAP_<SAPSID>_GlobalAdmin group exactly as specified in the correct uppercase and lowercase.

5. Select the following:
   a) Group scope: Global
   b) Group type: Security
6. Choose OK.

Creating the New SAP System Users <sapsid>adm and SAPService<SAPSID>

1. In Active Directory Users and Computers Console, right-click Users in Tree and choose:
   - New ➜ User ➜
2. Enter the following:
Note
Enter the <sapsid>adm and SAPService<SAPSID> user exactly as specified in the correct uppercase and lowercase.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input for &lt;sapsid&gt;adm</th>
<th>Input for SAPService&lt;SAPSID&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name:</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Initials:</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Last name:</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Full name:</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
<tr>
<td>User logon name:</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
</tbody>
</table>

3. Choose Next and enter the following:
   - Password: <password>
   - Confirm password: <password>
4. Select Password never expires

Note
Make sure that no other options are selected.

5. Choose Next ▶ Finish ◄.

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin Group

1. In the Users folder, double-click the newly created user account <sapsid>adm in the list on the right.
2. Choose Member ▶ Add ◄.
3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the list.

Note
By default, the user is also a member of the Domain Users group.

4. Choose OK twice.

Adding the SAPService<SAPSID> User to the SAP_<SAPSID>_GlobalAdmin Group

1. In the Users folder, double-click the newly created user account SAPService<SAPSID> in the list on the right.
2. Choose Member ▶ Add ◄.
3. Select the new SAP_<SAPSID>_GlobalAdmin group.
4. Choose Add to add it to the list, and then OK.
5. Choose OK to close SAPService<SAPSID> Properties.
3.9 Preparing the SAP System Transport Host

The transport host has a directory structure that is used by the SAP transport system to store transport data and metadata. When you install an SAP system, SAPinst by default creates the transport directory on the primary application server instance host in \usr\sap\trans.

If you do not intend to use the directory structure of the system you are going to install, but want to use another new transport directory or an already existing transport directory, you need to prepare that transport host:

- If the directory structure already exists, you must set up its security to allow the new system to write to it.
- If it does not yet exist, you must create the core directory structure and a share to export it for other computers as well as set the security on it.

Procedure

1. If the transport directory does not yet exist, do the following:
   a) Create the directory \usr\sap\trans on the host to be used as the transport host.
   b) Share the \usr\sap directory on the transport host as SAPMNT and put the security settings for Everyone to Full Control for this share. This enables SAPinst to address the transport directory in the standard way as \\SAPTRANSHOST\SAPMNT\trans.

2. Grant Everyone the permission Full Control for the transport directory.

Caution

Remove the Full Control to Everyone permission after you have finished the installation with SAPinst and only grant Full Control on this directory to the SAP_<SAPSID>_GlobalAdmin groups of all the systems that are part of your transport infrastructure. SAPinst assigns the appropriate rights with the help of an additional SAP_LocalAdmin group. For more information, see Automatic Creation of Accounts and Groups [page 114].

Note

If, during the installation with SAPinst, you select the checkbox SAP System will be under NWDI control on the SAPinst screen SAP System NWDI Landscape, SAPinst copies all SCAs belonging to the usage types or software units that you installed to the global transport directory. For more information, see SAP Library [page 14] at:
- Administrator’s Guide • Technical Operations for SAP NetWeaver • General Administrations Task • Software Life-Cycle Management • Software Logistics • SAP NetWeaver Development Infrastructure • Maintenance of an NWDI-Driven System Landscape ⇩
3.10 Generating the SAP Solution Manager Key

You need to generate the Solution Manager key because the installation tool prompts for it during the installation. Without this key, the installation process cannot continue. For more information, see SAP Note 805390.

Procedure

1. If SAP Solution Manager is not yet available in your system landscape, proceed as follows:
   a) Order SAP Solution Manager as described in SAP Note 628901.
   b) Install SAP Solution Manager as described in the documentation Installation Guide – SAP Solution Manager <release> on <OS>: <Database> which is available at:
      http://service.sap.com/solutionmanager SAP Solution Manager Installation Guides Release 4.0
2. Generate the SAP Solution Manager key as described in SAP Note 811923.

Result

The SAP Solution Manager system displays the key for which you are prompted during the installation of your SAP system.

3.11 Preparing the Installation DVDs

This section describes how to prepare the installation DVDs, which are available as follows:

- You normally obtain the installation DVDs as part of the installation package.
- You can also download the installation DVDs from SAP Service Marketplace, as described at the end of this section.

1. Identify the required DVDs for your installation [page 17] as listed below.

   Keep them separate from the remaining DVDs as this helps you to avoid mixing up DVDs during the installation.

Note

- The media names listed in the following table are abbreviated.
- You can find the Software Component Archives (SCAs) for the installation of SAP NetWeaver usage types on the NetWeaver Java DVD.
2. Make the required installation media available on each installation host.

**Note**

Depending on your installation type, one or more instances can reside on the same host. You need to keep this in mind when you make the required installation media available on each installation host.

For a standard system, you need to make all required installation media available on the single installation host.

Use one of the following methods to make DVDs available:

- **Before** the installation, copy DVDs manually to local hard disks.
- **During** the installation, use the SAPinst Media Browser dialog and copy the entire DVDs to the path you entered in the *Copy To* column.

**Caution**

- If you copy the DVDs to disk, make sure that the paths to the destination location of the copied DVDs do not contain any blanks.
- If you perform a domain installation and do not want to copy the DVDs but use network drives for mapping the installation DVDs, make sure that the `<sapsid>adm` user has access to the UNC paths of the network drives.

**Downloading Installation DVDs from SAP Service Marketplace (Optional)**

You normally obtain the installation DVDs as part of the installation package from SAP. However, you can also download installation DVDs from SAP Service Marketplace at:
3.11 Preparing the Installation DVDs

To extract the downloaded SAR files make sure that you use the latest SAPCAR version, which you can find on SAP Service Marketplace at [http://service.sap.com/swdc](http://service.sap.com/swdc). You need at least SAPCAR 700 or SAPCAR 640 with patch level 4 or higher because older versions of SAPCAR can no longer unpack current SAR files. For more information, see SAP Note 212876.

1. Create a download directory on the host where you want to run SAPInst.
2. Identify all download objects that belong to one installation DVD according to one or both of the following:
   - **Material number**
     All download objects that are part of an installation DVD have the same material number and an individual sequence number:
     `<material_number>_<sequence_number>`
     
     **Example**
     
     51031387_1  
     51031387_2  
     ...
   
   - **Title**
     All objects that are part of an installation DVD have the same title, such as `<solution>`<DVD_name>`<OS>` or `<database>`RDBMS`<OS>` for RDBMS DVDs.
3. Download the objects to the download directory.
4. Extract the individual download objects using SAPCAR, starting with the lowest sequence number – for example 51031387_1, then 51031387_2, and so on.
   During the download SAPCAR sets up the structure of the installation DVD.

**Note**

SAPCAR asks if you want to replace existing files, for example `LABELIDX.ASC`. Always accept with Yes.
3.12 Preparing z/OS for SAPinst

If you want to install the ASCS or SCS instance on z/OS – which is the procedure that we recommend for a high-availability system – you need to prepare z/OS for SAPinst. This includes installing the Java Runtime Environment Version 1.5 (JRE), which is required both for SAPinst and the SAPinst GUI.

Note

If required, you can perform a remote installation using a standalone SAPinst GUI on a separate Windows or UNIX host. This lets you perform the installation on a remote host, controlling it with the SAPinst GUI from a local host.
If you want to perform a remote installation, see Performing a Remote Installation with SAPinst [page 71]. In this case, you need at least JRE on the local host so that you can start the SAPinst GUI on that host.

Procedure

1. Check the JRE versions that are released for SAP systems in the Product Availability Matrix (PAM):
   a) Go to http://service.sap.com/pam.
   b) Choose SAP NETWEAVER ➔ SAP NetWeaver <version> ➔ in the selection tree in the right screen area.
   c) Choose the product version in the left screen area, if applicable
   d) Choose the JSE Platforms tab page.
2. Make sure a valid JRE version is installed:
   ■ If the JRE is not already installed, you need to download and install it.
     Note
     JRE is not part of the SAP shipment, it is part of the JDK (Java Development Kit).
     ■ If the JRE is already installed, check the installed version of JRE by entering the following:
     java -version

Note

SAPinst checks environment variable SAPINST_JRE_HOME for a valid Java runtime environment.
If SAPINST_JRE_HOME is not found, SAPinst also checks JAVA_HOME.
4 Installation

This section includes the installation steps that you have to perform for the:

- Standard system
- Additional application server instance
- Standalone host agent

**Standard System**

1. You install the SAP system with SAPinst [page 68].

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>In a standard system all mandatory instances are installed on one host in one installation run.</td>
</tr>
</tbody>
</table>

2. You continue with Post-Installation [page 83].

**High-Availability System**

1. If you want to perform a high-availability installation, see the installation guide SAP <product> <technology> on <AIX | Linux>: IBM DB2 for z/OS on SAP Service Marketplace at

2. You continue with Post-Installation [page 83].

**Additional Application Server Instance(s)**

You perform the following steps on each host where you install the additional application server instance(s).

1. You run SAPinst [page 68] to install the additional application server instance(s).

2. You continue with Post-Installation [page 83].

**Installation Steps for Additional Components and Tools for SAP NetWeaver CE (Optional)**

- You install additional components [page 78] for SAP NetWeaver Composition Environment, such as
  - Composition Tools
  - Adobe Document Services
  - Composite Voice
  - IDE Update Site
You install SAP Memory Analyzer [page 80] for SAP NetWeaver Composition Environment.

**Standalone Host Agent**

1. You run SAPinst [page 68] to install the Host Agent.
2. You continue with Post-Installation [page 83].

### 4.1 Running SAPinst

This procedure tells you how to install an SAP system with SAPinst. SAPinst includes a SAPinst GUI and a GUI server, which both use Java.

**Note the following information about SAPinst:**

- SAPinst normally creates the installation directory sapinst_instdir, where it keeps its log files, and which is located directly in the Program Files directory. If SAPinst is not able to create sapinst_instdir there, it tries to create sapinst_instdir in the directory defined by the environment variable TEMP.

  **† Recommendation**
  
  We recommend that you keep all installation directories until the system is completely and correctly installed.

- SAPinst creates a subdirectory for each installation option called \<sapinst_instdir>\<installation_option_directory>, which is located in %ProgramFiles%\.

- The SAPinst Self-Extractor extracts the executables to a temporary directory (TEMP, TMP, TMPDIR, or SystemRoot). These executables are deleted after SAPinst has stopped running. Directories called sapinst_exe.xxxxxx.xxxx sometimes remain in the temporary directory.
  
  You can safely delete them.

  The temporary directory also contains the SAPinst Self-Extractor log file dev_selfex.out, which might be useful if an error occurs.

  **⚠️ Caution**

  If SAPinst cannot find a temporary directory, the installation terminates with the error FCO-00058.

- During the installation, the default ports 21200, 21212, and 4239 are used for communication between SAPinst, GUI server, SAPinst GUI, and HTTP server. SAPinst uses port 21200 to communicate with the GUI server. The GUI server uses port 21212 to communicate with SAPinst GUI. 4239 is the port of the HTTP server, which is part of the GUI server. You get an error message if one of these ports is already in use by another service.

  In this case, open a command prompt and change to the required directory as follows:
cd <DVD drive>:\DATA_UNITS\IM WINDOWS_<platform>.

Enter the following command in a single line:

```plaintext
sapinst.exe SAPINST_DIALOG_PORT=<free_port_number_sapinst_to_gui_server>
GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>
GUISERVER_HTTP_PORT=<free_port_number_http_server>
```

To get a list of all available SAPinst properties, go to the directory 
(%TEMP%\sapinst_exe.xxxxxx.xxxx), after you have started SAPinst, and enter the following command:

```plaintext
sapinst.exe -p
```

If you want to terminate SAPinst and the SAPinst Self-Extractor, choose one of the following options:
- Right-click the icon for the SAPinst output window located in the Windows tray and choose Exit.
- Click the icon for the SAPinst output window located in the Windows tray and choose File Exit.

**Using SAPinst GUI**

The following table shows the most important functions that are available in SAPinst GUI:

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function key</td>
<td>F1</td>
<td>Displays detailed information about each input parameter</td>
</tr>
<tr>
<td>Menu option</td>
<td>File Exit</td>
<td>Stops the SAPinst GUI, but SAPinst and the GUI server continue running</td>
</tr>
<tr>
<td>Menu option</td>
<td>SAPinst Log Browser</td>
<td>Displays the Log Viewer dialog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This dialog enables you to access the following log files directly:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Installation log (sapinst_dev.log)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Log files from the SAPinst GUI server</td>
</tr>
<tr>
<td>Menu option</td>
<td>SAPinst Cancel</td>
<td>Cancels the installation with the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Stop</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stops the installation (SAPinst GUI, SAPinst and the GUI server) without</td>
</tr>
<tr>
<td></td>
<td></td>
<td>further changing the installation files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can restart and continue the installation later from this point.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Continue</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continues the installation</td>
</tr>
<tr>
<td>Message button</td>
<td>Retry</td>
<td>Performs the installation step again (if an error has occurred)</td>
</tr>
</tbody>
</table>
### Prerequisites

- You use an account with the required user authorization to install the SAP system with the SAPinst tool [page 58].
- You need at least 300 MB of free space in the installation directory for each installation option. In addition, you need 60-200 MB free space for the SAPinst executables.
- Make sure that you have defined the most important SAP system parameters as described in Basic SAP System Parameters [page 32] before you start the installation.
- Check that your installation host(s) meets the requirements for the installation option(s) that you want to install. For more information, see Running the Prerequisite Checker [page 41].
- Before starting the installation process, make sure that the database is up and running and that the DB2 Connect instance is installed correctly.
  For more information, see Installation of Multiple Components in One Database [page 29].

### Procedure

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD by double-clicking `sapinst.exe` from the following path:
   ```
   <DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>_<DB>
   ```
   SAPinst GUI starts automatically by displaying the Welcome screen.
   However, if there is only one component to install, SAPinst directly displays the first input dialog without presenting the Welcome screen.

   ![Note]
   
   If you want to use a virtual host name, start SAPinst as follows:
   ```
   sapinst.exe SAPINST_USE_HOSTNAME=<virtual host name>
   ```

3. In the Welcome screen, choose the required SAPinst installation option from the tree structure.
   For more information, see SAPinst Installation Options [page 72].
4.2 Performing a Remote Installation with SAPinst (Optional)

You use this procedure to install your SAP system on a remote host. In this case, SAPinst and the GUI server run on the remote host, and SAPinst GUI runs on the local host. The local host is the host from which you control the installation with SAPinst GUI.
4.3 **SAPinst Installation Options**

This section provides information about the following in SAPinst:

- **Installation Options**
- **Software Life-Cycle Options**

![Note]

- Choose the required installation options from the tree structure **exactly** in the order they appear for each system variant.
- If required, install an additional application server instance for a standard system by choosing 
  
  ![<SAP System>](Software Life-Cycle Options > Additional Application Server Instances > Additional application server instance)

- If required, install additional CE components by choosing 
  
  ![<SAP System>](Software Life-Cycle Options > Additional CE Components > Additional CE components)

- If required, install SAP Memory Analyzer by choosing 
  
  ![<SAP System>](Software Life-Cycle Options > SAP Memory Analyzer > SAP Memory Analyzer)
Installation Options

You choose SAP Systems with <your database> to install a SAP system with usage types or software units. You can install the following system variants:

- **Standard System**

  **Installation Options for a Standard System**

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
</table>
  | Standard System     | Installs a complete SAP system including the following instances on one host:  
  |                     | ⚫ Central services instance (SCS)  
  |                     | ⚫ Primary application server instance  
  |                     | You can install a standard system in the following modes:  
  |                     | ⚫ Typical Mode  
  |                     | If you choose Typical, the installation automatically uses default settings. You only have to respond to a small selection of prompts. However, you can change any of the default settings on the parameter summary screen.  
  |                     | ⚫ Custom Mode  
  |                     | If you choose Custom, the installation prompts you for all parameters. At the end, you can change any parameter on the parameter summary screen.  
  |                     | Caution  
  |                     | The database is always installed on z/OS.  
  |                     | Note  
  |                     | You require at least usage type AS Java or AS ABAP. You can choose the usage types or software units on the next screen.  

  **Only valid for**: HA (MCS); HA (UNIX); HA (z/OS)

- **High-Availability System**

  **Installation Options for a High Availability System**

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
</table>
  | Central Services Instance     | Installs a central services instance (SCS)  
  | (SCS)                         |         |
  | Database Instance              | Installs a database instance  
  | Enqueue Replication Server    | Installs an enqueue replication server, which contains a replica of the lock table (replication server)  
  | Instance                      |         |
### Installation Options

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Application Server Instance</td>
<td>Installs a primary application server instance and enables additional usage types or software units</td>
</tr>
<tr>
<td>Additional Application Server Instance</td>
<td>Installs an additional application server instance</td>
</tr>
</tbody>
</table>

**Software Life-Cycle Options**

You use the options located in this folder to perform the following tasks or to install the following components:

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
</table>
| Additional Preparations               | - **Host Agent**  
Choose [Additional Preparations ➔ Host Agent ➔ Host Agent ➔] to install the host agent with the profiles SAPSystem=99 and SAPSystemName=SAP.  
The host agent contains all of the required elements for centrally monitoring any host.  
Normally you do not need to install a standalone host agent, because it is automatically installed during the installation of all SAP NetWeaver components, except TREX.  
You only need to install a standalone host agent when:  
* You want to centrally monitor a host that does not have an SAP component.  
* You want to perform an upgrade to SAP NetWeaver.  
For more information, see [Standalone Host Agent](#) [page 21].  
- **Operating system users and groups**  
Creates all operating system users for your SAP system if they do not yet exist.  

**Caution**  
- Perform this SAPinst option **before** you start the installation of your SAP system.  
- Make sure that you have the **required user authorization** [page 38] for these accounts before you start the installation.

- **Prerequisites check**  
Choose [Additional Preparations ➔ Prerequisites Check ➔] if you want to check your hardware and software requirements **before** you start the installation.  
Otherwise, SAPinst automatically checks the hardware and software requirements during the installation with the **Prerequisite Checker**. If any changes are necessary to the SAP system or operating system settings, SAPinst automatically prompts you. For more information, see [Running the Prerequisites Checker in Standalone Mode](#) [page 41].

| Additional Application Server Instances | Choose [Additional Application Server Instances ➔ Additional Application Server Instance ➔] to install one or more additional application server instance(s) in an already installed SAP system, if required. |
### 4.4 Interrupted Installation with SAPinst

The SAP system installation might be interrupted for one of the following reasons:

- An error occurred during the dialog or processing phase:
  - SAPinst does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description about the choices listed in the table below as well as a path to a log file that contains detailed information about the error.
- You interrupted the installation by choosing Exit in the SAPinst menu.

The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retry</strong></td>
<td>SAPinst retries the installation from the point of failure without repeating any of the previous steps. This is possible because SAPinst records the installation progress in the <strong>keydb.xml</strong> file. We recommend that you view the entries in the log files, try to solve the problem and then choose Retry. If the same or a different error occurs again, SAPinst displays the same dialog box again.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>SAPinst stops the installation, closing the dialog box, the SAPinst GUI, and the GUI server. SAPinst records the installation progress in the <strong>keydb.xml</strong> file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td><strong>Continue</strong></td>
<td>SAPinst continues the installation from the current point.</td>
</tr>
</tbody>
</table>

---

**Additional CE Components**

Choose this option to install additional CE components, such as:

- Composition Tools
- Adobe Document Services (if available for your platform)
- Composite Voice
- IDE Update Site

**SAP Memory Analyzer**

Choose this option to install SAP Memory Analyzer. SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive.

**System Copy**

Choose this option to perform a system copy. For more information, see the system copy guide for your SAP system at:

4.5 Starting SAPinst GUI Separately (Optional)

You use this procedure to start SAPinst GUI separately. You might need to start SAPinst GUI separately in the following cases:

- You have logged off from SAPinst.
  - If you logged off during the installation and you later want to reconnect to the installation while it is still running, you can start SAPinst GUI separately.
- You want to perform a remote installation [page 71].
  - If SAPinst GUI runs on a different host from SAPinst and the GUI server, you have to start SAPinst GUI separately.

Starting SAPinst GUI on Windows

1. Log on as a member of the local administrators group.
2. Insert the SAP Installation Master DVD into your DVD drive.
3. Change to the directory of the sapinst executables:
   
   `<DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>_.<DB>`

   **Note**
   If you want to start SAPinst GUI on a Windows 32-bit operating system, change to the following directory:
   
   `<Installation_Master_DVD>:\DATA_UNITS\SAPINSTGUI_710_WINDOWS_I386`

4. Start SAPinst GUI by double-clicking `sapinstgui.exe`
   SAPinst GUI starts and tries to connect to the GUI server and SAPinst, using the local host as default.
   If SAPinst and the GUI server are running on another host, SAPinst GUI cannot connect and the `SAP Installation GUI Connection` dialog appears.
   In this case, enter the name of the host on which SAPinst is running and choose `Log on`. The first dialog of the installation appears and you can perform the remote installation from your local host.

   **Note**
   Optionally you can start `sapinstgui.exe` with the following parameters:
   
   - `host=<host name>`, where `<host name>` is the host name of the installation host
   - `port=<nr>`, where `<nr>` is the port number for the connection to the GUI server
   - `-accessible` enables the Accessibility mode

   **Example:**
   
   `./sapinstgui.exe host=lsi1209 port=3000 -accessible`

**Starting SAPinst GUI on UNIX**

1. Log on as user `root`.

   **Caution**
   Make sure that the root user has not set any environment variables for a different SAP system or database.

2. Mount your Installation Master DVD.

   **Note**
   Mount the DVD locally. We do **not** recommend that you use Network File System (NFS).

3. Change to the directory of the sapinst executables:
   
   `<mountpoint_of_Installation_Master_DVD>/DATA_UNITS/IM_<OS>_<DB>`
4.6 Entries in the Services File Created by SAPinst

After the installation has finished successfully, SAPinst has created the following entries for port names in `<drive>:\WINDOWS\system32\drivers\etc\services`:

- sapdpXX = 32XX/tcp
- sapdbXXs = 47XX/tcp
- sapgwXX = 33XX/tcp
- sapgwXXs = 48XX/tcp

where XX is set from 00 to 99.

Note

If there is more than one entry for the same port number, this is not an error.

4.7 Installing Additional Components (Optional)

You can install the following additional components:
4.7 Installing Additional Components (Optional)

- Composition Tools
- Adobe Document Services (if available for your platform)
- Composite Voice
- IDE Update Site

Prerequisites
You need to fulfill the same hardware and software requirements as for your already installed production system plus an additional 2 GB RAM.

The Composition Tools and Composite Voice component make use of the Visual Composer. Visual Composer is a Web browser based tool to model user interfaces. To run Visual Composer, the following programs must be installed on the client computer from which you access Visual Composer:

- Microsoft Internet Explorer 6.0 SP1 or higher
- Adobe SVG Viewer 3.0
- Microsoft XML Parser 4.0 or higher

Note

- Before installing additional components, you need to stop all application servers manually.
- Before installing additional components and in the case that you made changes to the default template settings, see SAP Note 953763.

Procedure

Note

When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, eiadm). During the installation SAPInst does a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPInst [page 68].
3. In the Welcome screen, choose → SAP NetWeaver CE Productive System → Software Life-Cycle Options → Additional CE Components → Install Additional Components ⬤.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   - If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.
4.8 Installing SAP Memory Analyzer (Optional)

SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive. New and innovative analysis techniques support the user with a fast and powerful feature set.

The tool (Eclipse RCP application) was developed to analyze real productive heap dumps, which tend to get enormous in size with hundreds of millions of objects. Performance, low resource consumption and especially the newly developed innovative analysis techniques make it a helpful tool, even to small application heap dumps.

You can install SAP Memory Analyzer as an additional tool.

---

**Note**

If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.

After the installation, you can access the offline documentation by choosing Start > All Programs > SAP NetWeaver Composition Environment > <SAPSID>.

5. Follow the screens and enter the required parameters.

**Note**

For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press [F1].

After you have entered all requested input parameters, SAPinst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog Execution of <Option_Name> has been completed successfully.

**Note**

After installing additional components, you need to perform CE-specific post-installation activities [page 93] to get the system up & running.
Procedure

Note
When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, ce1adm). During the installation SAPInst performs a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPInst [page 68].
3. In the Welcome screen, choose SAP NetWeaver CE Productive System → Software Life-Cycle Options → SAP Memory Analyzer → Install SAP Memory Analyzer ➜.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

Note
If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.
After the installation, you can access the offline documentation by choosing Start → All Programs → SAP NetWeaver Composition Environment → <SAPSID> ➜.

5. Follow the screens and enter the required parameters.

Note
For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press F1.

After you have entered all requested input parameters, SAPInst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPInst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPInst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPInst shows the dialog Execution of <Option_Name> has been completed successfully.
This page is intentionally left blank.
5 Post-Installation

This section includes the post-installation steps that you have to perform for the:

- Standard or high-availability system
- Additional application server instance
- Standalone host agent

**Standard, Distributed, or High-Availability System**

Note
Since an SAP on IBM DB2 for z/OS system is always a distributed constellation, we only offer a standard or high-availability installation option.

1. If required, you perform a full system backup [page 96] immediately after the installation has finished.
2. You configure the Windows Server 2008 Firewall [page 84].
3. You check whether you can log on to the SAP system [page 85].

Note
In a distributed or high-availability system you check whether your can log on to every instance of the SAP system that you installed.

4. You ensure user security [page 86].
5. You install the SAP license [page 88].
6. **Windows Server 2008 only:** If required, you set up symbolic links for application servers [page 89].
7. You configure the remote connection to SAP support [page 90].
8. On the primary application server instance host, you apply the latest kernel and Support Packages [page 90].
9. You check the Java manuals [page 92] for information that is relevant for running your Java system.
10. You perform CE-specific post-installation steps [page 93].
11. You perform a full system backup [page 96].
12. If you want or need to implement the E2E Root Cause Analysis scenario, you have to perform post-installation steps for the Diagnostics Agent [page 97] on your central instance and/or dialog instance(s).

**Additional Application Server Instance**

1. You check whether you can log on to the additional application server instance [page 85].
2. You perform a full system backup [page 96].
3. If you want or need to implement the E2E Root Cause Analysis scenario, you have to perform
post-installation steps for the Diagnostics Agent [page 97] on your central instance and/or dialog instance(s).

**Standalone Host Agent**

You perform the post-installation steps for the Host Agent [page 91].

### 5.1 Configuring the Windows Server 2008 Firewall

As of Windows Server 2008, the Windows Firewall is turned on by default. It is configured to allow
only a small set of Windows-specific inbound IP connections. Outbound connections by default are
not limited to rules and are therefore not restricted by the firewall.

**Note**

- The default firewall settings are valid for the out-of-the-box installation of Windows Server
  2008 and apply to local policies. For domain policies that override local policies, other rules
  might apply.
- To disable the Windows firewall temporarily, proceed as follows:
  1. Choose Start ➤ Administrative Tools ➤ Windows Firewall with Advanced Security ➤
  2. Right-click Windows Firewall with Advanced Security and choose Properties.
  3. To turn off the firewall, choose the relevant profile (in most cases Domain Profile) and set the
     Firewall state to Off.
  4. To turn on the firewall again, set the Firewall state to On.

For the SAP system to operate, you might have to configure the Windows firewall and define a set of
**Inbound Rules** for the TCP/IP port numbers that are used by your system.

For more information about the port numbers used, see the documentation TCP/IP Ports Used by
SAP Applications at:

http://service.sap.com/security ➤ Security in Detail ➤ Infrastructure Security ➤

Ports listed with the default value *Not active* in this document are not configured.

**Procedure**

This procedure describes how to set **Inbound Rules** for the ports of an installed ABAP server that was
installed with instance number 00.

1. Choose Start ➤ Administrative Tools ➤ Windows Firewall with Advanced Security ➤
   The New Inbound Rule Wizard starts.
3. For Rule Type, select Port and choose Next.
4. For Protocol and Ports, select port type TCP or UDP depending on the port type used.
   Select Specific local ports, and enter the port numbers for which you want to apply the new rule.
Choose Next.
5. For Action, select Allow the connection, and choose Next.
6. For Profile, keep Domain, Private and Public selected, and choose Next.
   For more information, see the link Learn more about profiles on this screen.
7. Enter the Name, for example SAP ABAP Server 00, and Description for the new rule.
8. Choose Next.
9. Choose Finish to save the rule.
   The new inbound rule appears in the Inbound Rules list. To modify the settings, right-click on
   the rule and choose Properties.

Note
If you want to use, for example, a different IP scope for port 50013, which is used by the connection
SAP Start Service – SAP Management Console, you can restrict the IP access to a small number of
SAP Administrators. Then delete this port from the SAP ABAP Server 00 rule and create a new
rule for port 50013 with a more restrictive scope.

5.2 Logging On to the Application Server

You need to check that you can log on to the application server using the following standard users:

Java Standalone Users

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>You create this user manually during the installation process.</td>
</tr>
</tbody>
</table>

Recommendation
We recommend that you call the user J2EEADM_<SAPSID>Java System>
The maximum length is 12 characters.

Prerequisites
- The SAP system is up and running.

Logging On to the Java Application Server
You access AS Java with a URL using a Web browser from your client machines. To log on to the Java
application server, proceed as follows:
1. Start a Web browser and enter the following URL:
   
   \[http://\langle hostname of Java EE Engine Server\rangle:5<Instance_Number>00\]
   
   \[Note\]
   
   You must always enter a two-digit number for \langle Instance_Number\rangle. For example, do not enter 1 but instead enter 01.
   
   \[Example\]
   
   If you installed the SAP NetWeaver Application Server Java on host saphost06 and the instance number of your SAP NetWeaver Application Server Java is 04, enter the following URL:
   
   \[http://saphost06:50400\]
   
   The start page of the SAP NetWeaver Application Server Java appears in the Web browser.
2. Log on by pressing the icon of any of the provided applications, for example the \textit{SAP NetWeaver Administrator}.

\section*{5.3 Ensuring User Security}

You need to ensure the security of the users that SAPinst creates during the installation. For security reasons, you also need to copy the installation directory to a separate, secure location — such as a DVD — and then delete the installation directory.

\[Recommendation\]

In all cases, the user ID and password are only encoded when transported across the network.
Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC.

For more information, see the \textit{SAP Library} [page 14]:

\begin{itemize}
\item Function-Oriented View \quad Security \quad Network and Transport Layer Security
\end{itemize}

\[Caution\]

Make sure that you perform this procedure \textbf{before} the newly installed SAP system goes into production.

\section*{Prerequisites}

If you change user passwords, be aware that SAP system users might exist in multiple SAP system clients (for example, if a user was copied as part of the client copy). Therefore, you need to change the passwords in all the relevant SAP system clients.
Procedure
For the users listed below, take the precautions described in the relevant SAP security guide, which you can find on SAP Service Marketplace at http://service.sap.com/securityguide:

<table>
<thead>
<tr>
<th>Operating System Users</th>
<th>User</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>&lt;sapid&gt;adm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td>Operating system user</td>
<td>SAPService&lt;sapid&gt;</td>
<td>User to run the SAP system</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Host Agent User</th>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td></td>
<td>SAP system administrator You do not need to change the password of this user after the installation. This user is for administration purposes only.</td>
</tr>
</tbody>
</table>

Note
You can set up Java standalone users with the SAP User Management Engine (UME) in one of the following ways:

- With the users stored in an external ABAP system – see the first table below
- With the users stored in the database – see the second table below

The next two tables show these ways of managing the users.

<table>
<thead>
<tr>
<th>SAP System Users Stored in an External ABAP System</th>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>This user's password is stored in secure storage. Therefore, whenever you change the administrator's password, you must also change the password in secure storage with the Config Tool. For more information, see Checking the SAP Java Documentation [page 92].</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>We recommend that you call the user J2EE_ADMIN_&lt;SAPSID_Java_System&gt;</td>
</tr>
<tr>
<td>The maximum length is 12 characters.</td>
</tr>
</tbody>
</table>
## 5.4 Installing the SAP License

You must install a **permanent** SAP license. When you install your SAP system, a **temporary** license is automatically installed. This temporary license allows you to use the system for **only four weeks** from the date of installation.

**Caution**

**Before** the temporary license expires, you must apply for a permanent license key from SAP. We recommend that you apply for a permanent license key as soon as possible after installing your system.
5.5 Creating Symbolic Links on Windows Server 2008 for Application Servers

With Windows Server 2008 you can create symbolic links for additional application server instances to simplify their administration.

Symbolic links for application servers let you access from your local host the SYS directory that is located on the global host, without having to specify its UNC path. Instead you can browse, for example in the Windows explorer on your local host to the SYS directory and its subdirectories on the global host.

Procedure

To create symbolic links, perform the following steps:

1. In the Start menu, right-click on Command Prompt and choose Run as administrator.

2. Enter the following command in a single line:

   ```cmd
   mklink /d <localdisk>:\usr\sap\<SAPSID>\SYS \\<sapglobalhost>\sapmnt\<SAPSID>\SYS
   ```

   **Note**
   
   Enter a blank before `\\<sapglobalhost>\`. 

3. If you use a central transport directory, you can also create the following link:

   ```cmd
   mklink /d <localdisk>:\usr\sap\trans \\<trans_dir_host>\sapmnt\trans
   ```

   **Note**
   
   The transport directory host `<trans_dir_host>` and the `<sapglobalhost>` can be identical.

**Caution**

The command `mklink` creates the link without checking whether the link target exists or is accessible. If the link does not work after you created it, make sure that it exists and check the accessibility of the UNC path.
5.6 Configuring the Transport Management System

You have to perform some steps to be able to use the Transport Management System.

Procedure

1. Perform post-installation steps for the transport organizer:
   a) Call transaction SE06.
   b) Select Standard Installation.
   c) Choose Perform Post-Installation Actions.
2. Call transaction STMS in your SAP Solution Manager system to configure the domain controller in the Transport Management System (TMS).

Result

You can now perform Java transports in the TMS of your SAP Solution Manager system.

More Information

For more information, see the SAP Library [page 14]:

Function-Oriented View ➤ Application Server ABAP ➤ Administration Tools for AS ABAP ➤ Change and Transport System ➤

5.7 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the EarlyWatch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP. For more information, see SAP Service Marketplace at http://service.sap.com/remoteconnection.

5.8 Applying the Latest Kernel and Support Packages

You have to apply the latest kernel and Support Packages for your SAP system from SAP Service Marketplace.

Caution

Before you apply support packages, make sure that you read the release notes for your SAP system. You can find these at http://service.sap.com/releasesnotes. The release notes might include information about steps you have to perform after you have applied the support packages.

You can use Java Support Package Manager (JSPM) to apply both the latest ABAP+Java or Java kernel and Java support packages.
JSPM is a Java standalone tool that you can use with SAP NetWeaver 7.1. JSPM uses the Software Deployment Manager (SDM) to apply support packages and patches and to deploy software components.

For more information about JSPM and how to use this tool, see the SAP Library [page 14]: ▶ Administrator’s Guide ▶ Technical Operations for SAP NetWeaver ▶ General Administration Tasks ▶ Software Life-Cycle Management ▶ Software Logistics ▶ Application Server Java (AS Java) Software Logistics ▶ Software Maintenance ▶ Java Support Package Manager (JSPM) ◄


**Procedure**

1. **Apply the latest kernel.**
   We recommend that you replace the installed kernel with the latest kernel from SAP Service Marketplace. In particular, you should replace the installed kernel if:
   - You installed the kernel executables locally on every host.
   - Your primary application server instance host runs on a different operating system than your additional application server instance host.

   For more information about how to download a kernel, see SAP Note 19466.

   To exchange the ABAP+Java kernel, you can use Java Support Package Manager (JSPM).

2. **Apply Support Packages.**
   a) Alternatively, you can download Support Packages from:

       <http://service.sap.com/patches>

   b) Apply the Java Support Packages to your SAP system with the help of the Java Support Package Manager (JSPM).

   For more information about the availability of Support Packages, see:

       <http://service.sap.com/ocs-schedules>

   For more information about how to update your CE system, see the documentation SAP NetWeaver Composition Environment 7.1 — Update Guide SP<xx>, available at


---

**5.9 Post-Installation Steps for the Host Agent**

You have to perform the following steps on each host where the host agent is installed. This applies whether the host agent is installed on a host within the SAP system or standalone on another host.

**Procedure**

1. **You check whether the installed services are available as follows:**

   ![Image](image-url)
a) Log on as user sapadm.
b) Check whether the following services are available:
   - The control program saphostexec
   - The operating system collector saposcol
   - The SAP NetWeaver Management agent S AphostControl (sapstartsrv in host mode)

Note
When the host is booted, the services SAPHostControl and SAPHostExec automatically start the installed programs

2. You configure the host agent according to your requirements.

More Information
For more information, see the SAP Library [page 14]:
- Function-Oriented View ➤ Application Server ABAP ➤ Administration Tools for AS ABAP ➤ Monitoring in the CCMS ➤ Infrastructure of the SAP NetWeaver Management Agents ➤

5.10 Checking the SAP Java Documentation

Here you can find information in the SAP Library about the configuration of Application Server Java (AS Java) and about SAP Java technology.

Procedure

1. Choose the following in the SAP library [page 14]:
   - Function-Oriented View ➤ Application Server Java ➤ AS Java (Application Server Java) ➤

2. Check the following documentation for information relevant to running your Java system:

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>➤ Application Server Infrastructure</td>
<td>This documentation provides an overview of the architecture of the Application Server Java (AS Java). It contains information on:</td>
</tr>
<tr>
<td>➤ Architecture of the SAP NetWeaver Application Server ➤ Architecture of AS Java ➤</td>
<td>- Java cluster architecture</td>
</tr>
<tr>
<td></td>
<td>- Application Server Java (AS Java) system architecture</td>
</tr>
<tr>
<td></td>
<td>- Zero Administration (technical configuration within AS Java)</td>
</tr>
</tbody>
</table>
### Manual Contents

**Application Server Java:**
- **Administration**
  - This documentation describes how to administer the SAP system, focusing on AS Java. It contains information on:
    - Administration Tools
      - SAP Management Console
        - The SAP Management Console (SAP MC) provides a common framework for centralized system management. It lets you monitor and perform basic administration tasks on the SAP system centrally, thus simplifying system administration.
      - SAP NetWeaver Administrator
        - SAP NetWeaver Administrator is a Web-based tool for administration and monitoring that offers a single entry point to configure, administer, and monitor your SAP NetWeaver system, its components, and the applications running on it.
      - Config Tool
        - The Config Tool provides offline configuration of the SAP NetWeaver Application Server Java (AS Java) instances. It lets you modify the properties of all services, managers, and applications.
        - In addition, it enables you to manage log configurations offline, add filters, and edit the JVM parameters.
      - Administration Using Telnet
      - SAP Java Virtual Machine (SAP JVM)
      - The Startup Framework for AS Java
      - Administration Functions for Information Lifecycle Management

**Application Server Java:**
- **Identity Management of the Application Server Java**
  - Identity Management of the SAP NetWeaver Application Server (AS) Java enables you to manage users and roles for access to applications of the AS Java and the data, which the applications require. The user management engine (UME) provides identity management as a service of the AS Java.
  - This documentation contains information on:
    - User Management Engine
    - Authorization Concept of the AS Java
    - Configuring Identity Management
    - Administration of Users and Roles

**SAP High Availability**
- This documentation contains information on:
  - Cluster and Load Balancing (AS-Java)
  - Single points of failure for SAP NetWeaver AS Java

**Security:**
- **System Security**
  - This documentation contains information on additional system security functions for AS Java.

---

### 5.11 CE-Specific Post-Installation Activities

This section describes the steps that you have to perform after the installation has finished successfully.
Running the Configuration Wizard (Optional)

Note
You can run the configuration wizard only once and only directly after installing and patching your SAP system.

After SAPInst has finished, run the configuration wizard to apply automated configuration tasks to your system.
For SAP NetWeaver CE, you need to run the following configuration tasks, depending on the installed components:

- Configuration of Services Registry WebService Destinations
- Configuration and Mirroring of local NWDS Update Site
- Initial setup ADS in CE (if ADS is available on your platform)
- Change Management Service (CMS): Create an Application Skeleton
- Change Management Service (CMS): Modify a Software Component

For more information about how to start the configuration wizard, see the configuration documentation in the SAP Solution Manager.

Enabling Adobe Document Services
If you have installed SAP NetWeaver Composition Environment with the Adobe Document Services add-on a Windows platform, you must complete the following post-installation steps to enable the add-on. In case you have installed an AS Java cluster, apply the procedure to the central host, as well as to all hosts where additional application server instances are running.

1. Using the SAP Management Console, stop the AS Java system.
2. From the Start menu, open ▶ Control Panel ▶ Administrative Tools ▶ Computer Management ▶ Services and Applications ▶ Services ▷.
3. Select SAP\<SID\>\_<Instance_Number\> (for example, SAPCE1\_00) and open Properties from the context menu.
4. On the Log On tab page, enable the Local System account indicator.
5. Repeat the above steps for the second SAP\<SID\>\_<Instance_Number\> service that you see in the list.
6. Start the AS Java system.

Adobe LiveCycle Designer
For more information about how to install and configure the Adobe LiveCycle Designer see SAP Note 962763.
### Enabling Services Registry

You must apply additional configuration steps to enable Services Registry after you have installed an SAP NetWeaver Composition Environment system containing the following components:

- Java Application Server and Composition Platform
- Java Application Server and Adobe Document Services

To enable Services Registry, you must apply the following configuration template to your system:

`CE_Complete_Stack_production_full`

**Note**

For more information about what configuration templates are available, see *Configuration Templates* [page 100].


See also


### Configuring the Portal in SAP NetWeaver CE

After installing the portal in SAP NetWeaver CE, a number of deactivated or irrelevant tools are displayed in the UI. To display the correct portals tools for CE, proceed as follows:

1. Open a browser and log on to your portal as an administrator.
2. In the same browser session, enter the following URL:
   
   ```
   ```

   where `<host>` is the host name of your server and `<httpport>` is the port number of your server.
3. In the Portal Mode Configuration Tool, choose *Activate Development Mode* to restore the portal tools and content that are assigned to the development mode.
4. Restart or refresh your browser.
5. In the SAP Management Console, restart the server.

You may then continue with the mandatory and optional configuration steps as described in

Changing the Password for the Internet Communication Manager (ICM)

You can monitor and manage the Internet Communication Manager (ICM) from the command line program.

After the installation of your SAP NetWeaver CE system has successfully finished, you need to change the ICM password manually. To do so, proceed as follows:

1. Log on at operating system level to the computer where the ICM is running.
2. Start the program icmon with `icmon -a profile=<instance_profile>` to maintain the authentication file (default: authfile.txt).
3. Choose a to add a user.
4. Choose c to change the password of the existing user.
5. Choose s to save your settings.

Further Configuration Steps

After installing your SAP NetWeaver CE system and performing the post-installation steps to get the system up & running, you may need to perform further configuration steps.

Refer to the following documentation to proceed with your tasks:

- If you are a **system administrator**, refer to [http://help.sap.com/nwce](http://help.sap.com/nwce) ‣ Administrator’s Guide. It contains information about how to configure and administer your system.
- If you are a **developer**, refer to [http://help.sap.com/nwce](http://help.sap.com/nwce) ‣ Developer’s Guide. It provides guidelines for developing applications using the SAP NetWeaver CE.

⚠️ **Note**

The SAP NetWeaver CE documentation is also available offline as a part of your installation. To access it, choose ‣ Start ‣ All Programs ‣ SAP NetWeaver ‣ Composition Environment 1.0 ‣ Documentation.

### 5.12 Performing a Full System Backup

You must perform a full system backup after the configuration of your SAP system. If required, you can also perform a full system backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

**Prerequisites**

- You are logged on as user `<sapsid>adm`.
- You have shut down the SAP system and database.

**Procedure for SAP Systems on IBM DB2 for z/OS**

When you perform a system backup, you must include the following:

1. Database system
For more information on the database backup, see the section "Database Administration → Backup and Recovery Options" in the documentation SAP DBA Guide: DB2 for z/OS.

2. Application server file systems
3. System state
4. The following are optional:
   - z/OS operating system disk
   - Application server operating system disk

### 5.13 Post-Installation Steps for the Diagnostics Agent

To implement the E2E Root Cause Analysis scenario, you have to configure the Diagnostics Agent.

**Prerequisites**

You have installed an AS Java central instance or dialog instance.

**Procedure**

Plan the implementation of the SAP Solution Manager Diagnostics Agent as described in the Root Cause Analysis Installation and Upgrade Guide, which you can find at [http://service.sap.com/diagnostics](http://service.sap.com/diagnostics).
6 Additional Information

Here you find additional information about the installation of your SAP system. There is also information about how to delete an SAP system.

- Transporting Self-Developed Software Component Archives (SCA) into the System [page 99]
- Configuration Templates [page 100]
- Uninstalling SAP NetWeaver Composition Environment [page 101]
- Starting and Stopping the SAP System [page 108]
- Database Build Phase [page 109]
- Database Post Load Phase [page 111]
- saposcol, sapconsr and SAPCL [page 112]
- SAP System Security on Windows [page 112]
- Automatic Creation of Accounts and Groups [page 114]
- Deleting an SAP System [page 116]

6.1 Transporting Self-Developed Software Component Archives (SCA) into the System

Prerequisites
You have developed your own Software Component Archives (SCA) and want to transport them into your SAP NetWeaver CE system.

Procedure
To transport your SCAs to the SAP NetWeaver CE system, proceed as follows:

2. From an empty directory, run the update tool update<id>.exe.

   ![Note]
   If the tool displays descriptions such as Applying Support Packages, you can ignore them.

3. In the dialog screens, specify the directory where your SCAs are located.
4. Follow the on-screen instructions.
6.2 Configuration Templates

Configuration templates contain the predefined instance configuration for specific scenarios. They are automatically applied according to the installation option you have selected. The templates are designed to optimize system performance by applying certain configuration to the Java Virtual Machine and the application server, as well as by applying startup filters to AS Java services and applications to start only those relevant for the selected installation options.

The following table provides information about the available templates with SAP NetWeaver Composition Environment. In the template name, replace the `<system_mode>` parameter by `development` (for the templates relevant to systems installed in development mode) or `production` (for the templates relevant to systems installed in productive mode).

<table>
<thead>
<tr>
<th>Configuration Template</th>
<th>Selected Installation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_Java EE_&lt;system_mode&gt;_&lt;full&gt;</td>
<td>Java Application Server Installation</td>
</tr>
<tr>
<td>CE_Composition_Environment_&lt;system_mode&gt;_&lt;full&gt;</td>
<td>Java Application Server Installation + Composition Platform Installation</td>
</tr>
<tr>
<td>CE_Adobe_Document_Service_&lt;system_mode&gt;_&lt;full&gt;</td>
<td>Java Application Server Installation + Adobe Document Services Add-on Installation</td>
</tr>
<tr>
<td>CE_Composite_Voice_&lt;system_mode&gt;_&lt;full&gt;</td>
<td>Java Application Server Installation + Voice Add-on Installation</td>
</tr>
<tr>
<td>CE_Complete_Stack_&lt;system_mode&gt;_&lt;full&gt;</td>
<td>Java Application Server Installation + Composition Platform Installation + Adobe Document Services Add-on Installation + Voice Add-on Installation</td>
</tr>
</tbody>
</table>

If your selection cannot be mapped to one of the combinations in the above table, the template CE_Complete_Stack_<system_mode>_<full> is applied. It starts all applications and services needed to run the complete stack.

You can manually apply a different configuration template if you want to switch to another installation option. For example, by changing from template CE_Complete_Stack_<system_mode>_<full> to CE_Java EE_<system_mode>_<full>, you achieve shorter startup times and less memory consumption, but also less functionality since not all applications and services are running.


**Note**

Make sure that you do not apply a development template to a productive system or vice versa.
6.3 Uninstalling SAP NetWeaver Composition Environment

You have to uninstall all components of the SAP NetWeaver Composition Environment separately. You can uninstall your SAP NetWeaver CE system in different ways.

Uninstalling SAP NetWeaver CE
Choose Start Control Panel Add / Remove programs SAP System<SAPSID>.

Uninstalling SAP NetWeaver CE Using SAPinst
1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD as described in the section Installing SAP NetWeaver Composition Environment.
3. In the Welcome screen, choose Uninstall SAP System or Single Instances from the tree structure.
4. Follow the on-screen instructions.

Uninstalling the SAP Management Console
Since all SAP systems use the SAP Management Console, there is no uninstallation option for the SAP Management Console with SAPinst. If you are sure that you do not need the SAP Management Console any more, you can remove it using Start Control Panel Add / Remove programs.

6.4 SAP Directories

This section describes the SAP directories that SAPinst creates during the installation. SAPinst automatically creates the following directories during the installation:

- \usr\sap
  This directory is created on the:
  - **Global** host and **shared** it with the network share sapmnt
    For information on how to set up a high availability installation, see SAP Note 1022583.
  - On global hosts, the \usr\sap directory contains general SAP software, global and local (instance-specific) data.
  - For this, SAPinst creates the global directory \usr\sap\<SAPSID>\SYS, which physically exists only once for each SAP system. It consists of the following subdirectories:
    - global – contains globally shared data
    - profile – contains the profiles for all instances
    - exe – contains executable replication directory for all instances and platforms
  - **Local** host and **shared** with the name saploc.
    - On local hosts, the \usr\sap\<SAPSID>\<instance_name> directory contains copies of the SAP software and local (instance-specific) data.
6.4 SAP Directories

Note
Since SAP traces for the instance are created in `\usr\sap`, make sure there is sufficient space available in this directory. Changes in SAP profiles can also affect the disk space.

Note
The executables on the local host are replicated from those on the global host every time the local instance is started. The SAP copy program `sapcp` compares the binaries in the `<platform>` directory on the global host and the binaries in the `exe` directory on the application server. If the binaries in the `exe` directory are elder than those in the `<platform>` directory, `sapcp` replaces them with the newer version of the global host.

Other application servers access the global data using the Universal Naming Convention (UNC) path `\\<SAPGLOBALHOST>\sapmnt`. The SAP programs access their instance-specific data with the UNC path `\\<SAPLOCALHOST>\saploc`. If the UNC path points to a local directory, the local path (and not the UNC path) is used to access the directory.

In a high-availability system, the parameters `SAPGLOBALHOST` and `SAPLOCALHOST` have the same values on the global host.

`\usr\sap\trans`

The transport directory contains SAP software for the transport of objects between SAP systems. SAPinst by default creates it on the `SAPGLOBALHOST`.

If you want to have it created on another host, or if you want to use an already existing transport host of your SAP system landscape, you can specify another host during the installation. In this case, you have to prepare that host to allow the new SAP system to use it as transport host. For more information, see Preparing the SAP System Transport Host [page 62].

Directory Structure
The following figures show how the physical directory `\usr\sap` is shared on the global host in a central and in a high-availability system. In both cases, the UNC paths are used as follows:

- `\\<SAPGLOBALHOST>\sapmnt` to access global directories
- `\\<SAPLOCALHOST>\saploc` to access local instance-specific data

Note
There are the following instance names available in an SAP system:

- Central services instance: `SCS<No>`
- Primary application server instance: `J<Instance_Number>`
- Additional application server instance: `J<Instance_Number>`.
**Figure 6**: Directory Structure on the Global Host in a Standard (Central) Java System
6.5 Additional Information About SAPinst

The following sections provide additional information about SAPinst [page 68]:

- Interrupted Installation with SAPinst [page 105]
- Entries in the Services File Created by SAPinst [page 106]
- How to Avoid Automatic Logoff by SAPinst [page 106]
- Troubleshooting with SAPinst [page 107]
6.5.1 Interrupted Installation with SAPinst

The SAP system installation might be interrupted for one of the following reasons:

- An error occurred during the dialog or processing phase:
  SAPinst does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description about the choices listed in the table below as well as a path to a log file that contains detailed information about the error.
- You interrupted the installation by choosing Exit in the SAPinst menu.

The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retry</strong></td>
<td>SAPinst retries the installation from the point of failure without repeating any of the previous steps. This is possible because SAPinst records the installation progress in the keydb.xml file. We recommend that you view the entries in the log files, try to solve the problem and then choose Retry. If the same or a different error occurs again, SAPinst displays the same dialog box again.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>SAPinst stops the installation, closing the dialog box, the SAPinst GUI, and the GUI server. SAPinst records the installation progress in the keydb.xml file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td><strong>Continue</strong></td>
<td>SAPinst continues the installation from the current point.</td>
</tr>
</tbody>
</table>

**Procedure**

This procedure describes the steps to restart an installation, which you stopped by choosing Stop, or to continue an interrupted installation after an error situation.

1. Log on to your remote host as a user who is a member of the local administrators group.
2. Mount your Installation Master DVD.
3. Restart SAPinst by double-clicking sapinst.exe. You can also start SAPinst by entering the following commands at the Windows command prompt:
   ```
   cd <DVD drive>:\IM_WINDOWS<platform>
   ```
4. From the tree structure in the Welcome screen, select the installation option that you want to continue and choose Next.

   **Note**
   If there is only one component to install, the Welcome screen does not appear.

   The What do you want to do? screen appears.
5. In the What do you want to do? screen, decide between the following alternatives and confirm with OK.
## 6.5.2 Entries in the Services File Created by SAPinst

After the installation has finished successfully, SAPinst has created the following entries for port names in `<drive>:\WINDOWS\system32\drivers\etc\services`:

- sapdpXX = 32XX/tcp
- sapdbXXs = 47XX/tcp
- sapgwXX = 33XX/tcp
- sapgwXXs = 48XX/tcp

where XX is set from 00 to 99.

**Note**

If there is more than one entry for the same port number, this is not an error.

## 6.5.3 How to Avoid Automatic Logout by SAPinst

When you install the SAP system with SAPinst, the SAPinst installation tool checks whether the user account used for the installation has the required privileges and authorization.

For a domain installation, the account needs to be both a member of the local **Administrators** and the domain **Admins** group. For a local installation, the account needs to be a member of the local **Administrators** group.

In both cases, the user account must be authorized to:

- Act as part of the operating system
- Adjust memory quotas for a process
- Replace a process level token

If the user account does not have these rights assigned, SAPinst assigns them and automatically logs the account off to activate them. To avoid SAPinst logging the account off, you can set these rights manually before you start the installation.
Procedure

You perform the following steps to assign these rights to the user account used for the installation.

⚠️ Caution

Be aware that domain policies override locally defined policies. This means that if you want to grant domain administrator rights for a user who belongs to the local Administrators group, make sure that you have also defined domain administrator rights for this user on domain level.

2. In the Local Security Settings window, choose Local Policies ▶ User Rights Assignment 5.
3. Double-click the required right under Policy and choose Add User or Group.
4. In the Select Users and Groups window, choose the required user and choose Add.
   The selected user appears in the box below.
5. Confirm your entry and then repeat the steps for each remaining policy that the user requires for the installation.
6. Log off and log on again to apply the changes.

More Information

Required User Authorization for the Installation [page 58]

6.5.4 Troubleshooting with SAPinst

This section tells you how to proceed when errors occur during the installation with SAPinst. If an error occurs, SAPinst:

▪ Stops the installation
▪ Displays a dialog informing you about the error

Procedure

1. To view the log file, choose View Logs.
2. If an error occurs during the dialog or processing phase, do one of the following:
   ▪ Try to solve the problem.
   ▪ Abort the installation with Exit.
      For more information, see Interrupted Installation with SAPinst [page 105].
   ▪ Continue the installation by choosing Retry.
3. Check the log and trace files of the GUI server and SAPinst GUI in the directory %userprofile%\.sdtgui\ for errors.
   ▪ If GUI server or SAPinst GUI do not start, check the file sdtstart.err in the current
     %userprofile% directory.
If SAPinst GUI aborts during the installation without an error message, restart SAPinst GUI as described in Starting SAPinst GUI Separately [page 76].

6.6 Starting and Stopping the SAP System

You use this procedure to check that you can start and stop the SAP system after the installation with the SAP Microsoft Management Console (SAP MMC).

With a newly installed SAP MMC you can start or stop installed SAP instances locally on the host that you are logged on to. If the SAP MMC is configured for central system administration, you can start or stop the entire system from a single host.

For more information, see the SAP Library [page 14]:

Function-Oriented View ▶ Application Server ABAP ▶ Administration Tools for AS ABAP ▶ Monitoring in the CCMS ▶ SAP Microsoft Management Console: Windows ▶

Prerequisites

- You have logged on to the SAP system host as user <sapsid>adm.
- You have checked the settings for VM parameters as described in SAP Note 723909.

Procedure

1. Start the SAP MMC on the SAP system host by choosing Start ▶ All Programs ▶ SAP Management Console ▶.
2. Right-click the SAP system node and choose Start or Stop.
   All instances listed under the system node start or stop in the correct order.
3. If the SAP system is installed on multiple hosts (distributed system), you have the following options to start or stop your system:
   You have the following options to start or stop your system:
   - You start or stop the SAP instances using the SAP MMC on each host.
   - You add the remote instances to the SAP MMC configuration to start or stop all instances from a single SAP MMC.
   To do so, you configure the SAP MMC manually. For more information, see Changing the Configuration of the SAP MMC in the SAP MMC documentation.

You can also start and stop a UNIX system with the SAP MMC.
6.7 Database Build Phase

Note
This section only applies to customers using IBM DB2 for z/OS Version 8.
If you are using DB2 V9.1 z/OS, storage groups, tablespaces and databases are created implicitly.

Database Layout
The DB2 database layout for the SAP system differs considerably from other platforms. This design is
described in detail in SAP DBA Guide: DB2 for z/OS Additional Information Database Layout.
The DB2 datasets you use for the DB2 system must be managed by the Storage Management
Subsystem (SMS).

Note
You must use SMS in your SAP system. You can no longer use non-SMS managed DB2 datasets.

Changing Primary Quantity and Secondary Quantity
The installation process always adapts the primary and secondary allocation quantities for tablespaces
– if they reach a specific maximum or minimum.
SAPinst allows you to change these thresholds. The default values are:
- 400 MB for the maximum primary quantity
- 1 MB for the minimum secondary quantity

The following is an example of how this mechanism works:
The size of all tablespaces having a primary allocation size larger than 400 MB is reduced to this
maximum. On the other hand, all tablespaces having less than 1 MB are created with a primary
quantity of 1 MB.
To change the default thresholds, specify the new values in the dialog Tables.

Note
If you change the values, make sure that you enter the values in MB.

Database Layout Files
The first step of the build phase results in database layout files located in <INSTDIR>. They contain a
list of SQL statements that are created by SAPinst.
The database layout files are:
- stogroup.sql
- database.sql
- tblspace.sql_<nn>
  where <nn> is a two digit number between 00 and 09.
The following table shows the dependencies between the tablespace page size and the parameters **FREEPAGE** and **PCTFREE**. SAPinst creates the CREATE TABLESPACE statements in file `tblspace.sql` accordingly:

<table>
<thead>
<tr>
<th>Tablespace Page Size</th>
<th>FREEPAGE</th>
<th>PCTFREE</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 KB</td>
<td>16</td>
<td>20</td>
</tr>
<tr>
<td>8 KB</td>
<td>31</td>
<td>10</td>
</tr>
<tr>
<td>16 KB</td>
<td>31</td>
<td>5</td>
</tr>
<tr>
<td>32 KB</td>
<td>0</td>
<td>5</td>
</tr>
</tbody>
</table>

**Changing the Standard Database Layout**

⚠️ **Caution**

Take extreme care if you change database layout files. Only a few checks are made by subsequent installation steps. Otherwise, you may easily corrupt your installation. You **must not** change any tablespace, database, or storage group names.

To change the standard database layout, you have to set the stop flags in the dialog *Checkpoints for Database Layout*.

You can modify primary and secondary quantities, alter buffer pools, or use compression (if this is supported by the system). Before you start, make sure you have a backup copy of your database layout files.

**Executing the Database Layout Files**

During the build phase, the statements in the database layout files are executed. Each layout file has a corresponding log file:

- `stogroup.log`
- `database.log`
- `tblspace.log_<nn>`

The database layout files are executed in following sequence:

1. `stogroup.sql`
2. `database.sql`
3. `tblspace.sql_<nn>`

The tablespaces are created in parallel using `db2radm`, which is part of the SAP kernel. The degree of parallelism depends on the number of tablespaces (maximum of 10 at the moment).

If the execution of the database layout files fails, you must proceed as follows:
1. If objects have been incorrectly created, you must drop the database instance using the Uninstall function in SAPinst.
2. If all objects created so far are correct, remove the cause of the error and restart SAPinst. Only missing objects are created – existing objects are not changed.

Note
Check the corresponding log file for further details.

### 6.8 Database Post Load Phase

After the database load phases are completed, SAPinst performs several DB2-specific steps:

- Creates indexes for the catalog tables SYSIBM.SYSTABLESPACE and SYSIBM.SYSTABLES
- Updates DB2 catalog statistics using RUNSTATS
- Changes the tablespace options LOCKSIZE ROW and LOCKMAX 1000000 for all tablespaces

#### Creating Catalog Indexes

The indexes for SYSIBM.SYSTABLESPACE and SYSIBM.SYSTABLES are stored in the default stogroup SYSDEFLT. If the volumes in this stogroup are full, you need to add new volumes to this stogroup.

#### Updating DB2 Catalog Statistics

RUNSTATS is a DB2 utility that gathers summary information about the characteristics of the data in tablespaces, indexes, and partitions. This information is recorded in the DB2 catalog and is used by DB2 to select access paths to data during the bind process. The database administrator can use RUNSTATS for evaluating database design and determining when tablespaces or indexes must be reorganized.

Caution

The installation checks if the IBM DB2 Utilities (RUNSTATS) are installed. (This check only runs if the stored procedures are installed). If RUNSTATS is not installed, you have two options:

- You can skip the execution of RUNSTATS
- You can interrupt SAPinst to install the utilities.

Subsequently, you can restart SAPinst – and RUNSTATS is executed.

Skipping the execution of RUNSTATS means that you have to update the catalog statistics yourself using an equivalent product.

You can update DB2 statistics by calling the DB2 stored procedure DSNACCNO. For more information, see Stored Procedures Enablement in SAP DBA Guide: DB2 for z/OS.
6.9 saposcol, sapccmsr and SAPCL

- **saposcol**
  - The operating system collector saposcol provides information that can assist you in detecting resource bottlenecks.
  - saposcol gathers data on CPU load, paging activity, and so on. It logs the data in a shared memory segment. The logged data is read by the SAPCL program and can be made available to the SAP system using a remote function call (RFC).

- **sapccmsr**
  - This tool connects saposcol to the SAP application server.

- **SAPCL**
  - This stored procedure monitors the performance of the DB2 database.

**More Information**

- For more information about how to install saposcol, see the SAP Planning Guide: DB2 for z/OS.
- For more information and on how to install sapccmsr, see the Monitoring Setup Guide for NW <version>.
- For more information and on how to install SAPCL, see the SAP DBA Guide: DB2 for z/OS.

6.10 SAP System Security on Windows

In a standard SAP system installation, SAPinst automatically performs all steps relevant for security. Although SAPinst makes sure that the system is protected against unauthorized access, you must still check that no security breaches can occur.

For central and straightforward administration of the SAP system, you have to install distributed SAP systems with multiple application servers in a Windows domain. This section describes the user accounts and groups that SAPinst creates during a domain installation and shows how these are related to the SAP directories.

**User Accounts**

SAPinst creates the following accounts for SAP system administration:

- `<sapsid>adm`
  - This is the SAP system administrator account that enables interactive administration of the system.

- `<SAPService>SAPSID>`
  - This is the user account that is required to start the SAP system. It has the local user right to log on as a service.
  - The advantage of the additional SAPServiceSAPSID account is that it does not allow an interactive logon, which prevents abuse of the account. Therefore, you do not need to set an expiration date for the password and you do not have to set the option user must change password at next logon.
sapadm
This is the user for the SAP host agent. It is a member of the local Administrators group.
The host agent contains all of the required elements for centrally monitoring any host with the
Alert Monitor or the SAP NetWeaver Administrator.

Groups
SAPinst creates the following groups during a domain installation:

- **SAP_<SAPSID>_GlobalAdmin**
  This global group is a domain-level SAP administration group for organizing SAP system
  administrators. The only function of a global group is to group users at the domain level so that
  they can be placed in the appropriate local groups.

- **SAP_<SAPSID>_LocalAdmin**
  Only local groups are created and maintained on an application server. A local group can only be
  given permissions and rights to the system where it is located. The system is part of a particular
  domain, and the local group can contain users and global groups from this domain.

- **SAP_LocalAdmin**
  This group is created on all hosts, but is particularly important for the transport host. Members of
  the group have full control over the transport directory (`\usr\sap\trans`) that allows transports to
  take place between systems.
  The **SAP_<SAPSID>_GlobalAdmin** groups of all the SAP systems that are part of the transport
  infrastructure are added to the **SAP_LocalAdmin** group. As a consequence, the users `<sapid>adm`
  and **SAPService<SAPSID>** of all systems in the transport infrastructure are members of the
  **SAP_LocalAdmin** group and have the required authorizations necessary to initiate and execute
  transports.

SAP Directories
SAPinst protects the SAP directories under `\usr\sap\<SAPSID>` by only granting the group
**SAP_<SAPSID>_LocalAdmin** full control over these directories.
The following graphic illustrates the user accounts and groups created by SAPinst in a system
infrastructure consisting of two SAP systems.
6.11 Automatic Creation of Accounts and Groups

SAPinst automatically creates the accounts and groups required for the secure operation of the SAP system with Windows [page 112] during the installation.

Features

The following figures show the steps that SAPinst performs to create the users and groups and assign the required rights to SAP directories.

![Diagram showing User Groups and Accounts](image)

**Note**

An access control list (ACL) controls access to SAP system objects. For maximum security in the SAP system, only the following are members of all SAP system object ACLs:

- Local group SAP_<SAPSID>_LocalAdmin
- Group Administrators
- Account SYSTEM
### Figure 9: Creating Users and Groups

<table>
<thead>
<tr>
<th>Creation of Accounts</th>
<th>Creation of SAP user accounts</th>
<th>SAP Administrator &lt;sapsid&gt;adm</th>
<th>SAP Service Account &lt;sapsid&gt;Service&lt;sapsid&gt;</th>
<th>SAP Host Agent Account sapadm</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Creation and Modification of Global Group in the Domain</strong></td>
<td>Creation of global group SAP_&lt;SAPSID&gt;GlobalAdmin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Addition of &lt;sapsid&gt;adm and SAPService&lt;sapsid&gt; to group SAP_&lt;SAPSID&gt;_GlobalAdmin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Addition of &lt;sapsid&gt;adm to the local Administrators group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Addition of &lt;sapsid&gt;adm to the Windows domain user groups</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Creation and Modification of Local Group on Each Application Server</strong></td>
<td>Creation of the local group SAP_&lt;SAPSID&gt;_LocalAdmin on the application server</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Addition of the global SAP_&lt;SAPSID&gt;<em>GlobalAdmin to the local group SAP</em>&lt;SAPSID&gt;_LocalAdmin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Creation of the local group SAP_LocalAdmin on the application server</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Addition of the global group SAP_&lt;SAPSID&gt;_GlobalAdmin to the local group SAP_LocalAdmin on the application server</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Addition of the SAP_&lt;SAPSID&gt;_GlobalAdmin group to the local group SAP_LocalAdmin on the transport host</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Figure 10: Assigning Rights to SAP Directories

**Assignment of Rights for the SAP Directories**

For Administrators and SAP_LocalAdmin groups
Assignment of Full Control over:

- `usr`
- `usr\sap`
- `usr\sap\trans`
- `usr\sap\prfclg`

For Administrators and SAP_<SAPSID>_LocalAdmin groups
Assignment of Full Control over:

- `usr\sap\<SAPSID>`
6.12 Deleting an SAP System

This section describes how to delete a single instance, a standalone engine or a complete SAP system with the Uninstall option of SAPinst.

When you uninstall an SAP system, the database content is also deleted.

Note
With this SAPinst option you do not delete the database software.

Caution
You cannot delete an SAP system remotely, with one exception: the database instance host is deleted remotely.

Prerequisites
- This description assumes that you have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on with a user account that has the required authorization to run the SAPinst tool and the SAP system. For more information, see Required User Authorization for the Installation [page 58].

Procedure
1. Start SAPinst [page 68] and on the Welcome screen, choose:
2. Follow the instructions in the SAPinst input dialogs.

Note
For more information about the input parameters, place the cursor on the relevant field and press [F1] in SAPinst.

SAPinst first asks you which SAP instances you want to delete. Make sure that you delete the SAP instances in the order as described hereinafter.
- If you want to delete a standard system, in which all SAP instances reside on the same host (except for the database instance), you can do this in one SAPinst run.
- If you want to delete a high availability system, in which the SAP instances reside on different hosts, you have to run SAPinst to delete the required instances locally on each host in the following sequence:

Note
If you have your SCS or ASCS instance on z/OS, you must delete these manually.
a) You must delete the database instance first.
   Use the following option to delete the database instance:

   **Uninstall in SAPinst**

<table>
<thead>
<tr>
<th>Options</th>
<th>Remarks</th>
</tr>
</thead>
</table>
   | Uninstall | Select this option if you want to delete the database content. **Procedure**
   | | A) Select Uninstall, and the Remove Database screen appears.
   | | B) Select Remove Database or Parts to remove the database. |

   **Caution**
   Deleting a database is an irreversible action. All objects belonging to `<schema>` in the DB2 subsystem are lost.

   * After you have deleted the database, delete all SAP instances.
   * Alternatively, you can consider deleting and recreating the DB2 subsystem. Refer to the IBM DB2 for z/OS documentation for more information.

b) You delete the additional application server instance(s), if there are any.
c) You delete the primary application server instance.

d) You delete the ABAP central services instance.

3. If required, you can delete the directory `/usr/sap/trans` and its contents manually. SAPInst does not delete `/usr/sap/trans` because it might be shared.

### 6.13 Deleting the Database Instance

**Caution**
Keep in mind that deleting a database instance is an irreversible action. All objects belonging to `<schema>` in the DB2 subsystem are lost after this.

**Prerequisites**
Before deleting the database, you must stop all SAP instances belonging to this database.

**Procedure**
To delete the database instance:
6.13 Deleting the Database Instance

1. Log on as user `<sapsid>adm`.
2. Stop all application servers connected to the z/OS database server using `stopsap`.
3. Log on as user `root` and change to the `<INSTDIR>`
4. Start SAPinst.
5. Start the installation script `sapinst` from the following directory:
   `<SAP Installation Master DVD>/IM<x>`
7. Answer all questions on the screens that follow carefully.

⚠️ **Caution**

After you have deleted the database, delete all SAP instances.

Alternatively, you can consider deleting and recreating the DB2 subsystem. Refer to the IBM DB2 for z/OS documentation for more information.
© Copyright 2008 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft, Windows, Excel, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.

IBM, DB2, DB2 Universal Database, OS/2, Parallel Sysplex, MVS/ESA, AIX, S/390, AS/400, OS/390, OS/400, iSeries, pSeries, xSeries, zSeries, System i, System i5, System p, System p5, System x, System z, System z9, z/OS, AFP, Intelligent Miner, WebSphere, Netfinity, Tivoli, Informix, i5/OS, POWER, POWER5, POWER5+, OpenPower and PowerPC are trademarks or registered trademarks of IBM Corporation.

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Oracle is a registered trademark of Oracle Corporation.

UNIX, X/Open, OSF/1, and Motif are registered trademarks of the Open Group.

Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.

HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

Java is a registered trademark of Sun Microsystems, Inc.

JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, R/3, xApps, xApp, SAP NetWeaver, Duet, PartnerEdge, ByDesign, SAP Business ByDesign, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary.

These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies ("SAP Group") for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.

This document was created using stylesheet 2006-12-31 (V5.1beta [= 6.0 for E3]) and XSLT processor SAXON 6.5.2 from Michael Kay (http://saxon.sf.net/), XSLT version 1.
Disclaimer
Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components. Any Java™ Source Code delivered with this product is only to be used by SAP’s Support Services and may not be modified or altered in any way.

Legal Software Terms

Terms for Included Open Source Software
This SAP software contains also the third party open source software products listed below. Note that for these third party products the following special terms and conditions shall apply.

1. This software was developed using ANTLR.
2. SAP License Agreement for STLport
   SAP License Agreement for STLPort between
   SAP Aktiengesellschaft
   Systems, Applications, Products in Data Processing
   Dietmar-Hopp-Allee 16
   69190 Walldorf, Germany
   (hereinafter: SAP)
   and
   you
   (hereinafter: Customer)
   a) Subject Matter of the Agreement
      A) SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLport.org C++ library (STLport) and its documentation without fee.
      B) By downloading, using, or copying STLPort or any portion thereof Customer agrees to abide by the intellectual property laws, and to all of the terms and conditions of this Agreement.
      C) The Customer may distribute binaries compiled with STLPort (whether original or modified) without any royalties or restrictions.
      D) Customer shall maintain the following copyright and permissions notices on STLPort sources and its documentation unchanged: Copyright 2001 SAP AG
      E) The Customer may distribute original or modified STLPort sources, provided that:
         ■ The conditions indicated in the above permissions notice are met;
         ■ The following copyright notices are retained when present, and conditions provided in accompanying permission notices are met:
         Copyright 1994 Hewlett-Packard Company
         Copyright 1996.97 Silicon Graphics Computer Systems Inc.
         Copyright 1997 Moscow Center for SPARC Technology.
         Copyright 1999,2000 Boris Fomitchev
         Copyright 2001 SAP AG
     Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.
     Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no
representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Boris Fromitchev makes no representations about the suitability of this software for any purpose. This material is provided “as is”, with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

b) Support and Maintenance
SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.

All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

c) Exclusion of warranty
As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights.

Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

d) Limited Liability
A) Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.

B) If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.

C) In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.

D) SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.

E) The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.

F) The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

3. Adobe Document Services
Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. For information on Third Party software delivered with Adobe document services and Adobe LiveCycle Designer, see SAP Note 854621.

Documentation in the SAP Service Marketplace
You can find this document at the following address: https://service.sap.com/instguides
This page is intentionally left blank.